


























































































































































































































































































































would be inconvenient, to say the least. 

If you do decide to delete files and later realize that 
you need or want them, you can run the Installer 
once more to create fresh copies of them. (Some files, 
such as control panels, can be copied directly from the 
master system disks.) If reinstallation is too much 
trouble, copy each file to a floppy disk before you trash 
it. Then if you need it later, just drag it from the floppy 
to your System Folder. 

Removing Network Extensions 
Look inside the Extensions fOlder in the System folder. 
If you're not connected to a network and aren't sharing 
files, get rid of AppleShare (72K), File Sharing 
Extension ( 168K), and Network Extension (93K). These 
files, along with the File Sharing Monitor and Sharing 
Setup control panels (more about them later), are 
needed only if you share files with other Macs. Not only 
that, but file sharing uses about 300K of RAM when it's 
turned on. 

Removing Printer Drivers 
Look inside the Extensions folder in the System folder. 
Get rid of printer drivers for printers you'll never use. If 
you don't have an ImageWriter, trash the file named 
Image Writer ( 45K); if you don't have a Personal 
LaserWriter SC, trash its file (72K). And so on. 

Removing Miscellaneous Extensions 
Look inside the Extensions folder in the System folder. A 
couple of extensions you might want to trash are DAL 
(84K) and Finder Help (36K). DAL is used for accessing 
networked or remote databases; Finder Help contains the 
five screens you see when you choose Finder Shortcuts 
from the Help menu. (Read the screens before deleting 
Finder Help, though.) 

Reducing The Number Of Control Panels 
Look inside the Control Panels folder in the System 
folder. You can remove control panels that are inap­
propriate for your Mac. For example, if you have a 
black-and-white Mac, such as an SE, you don't need 
Color ( 12K). If you're not sharing files, get rid of File 
Sharing Monitor (SK), Sharing Setup (SK), and Users 
& Groups (SK). Map (29K) can also be removed. 

Another file you can probably do without is Easy 
Access (12K), which lets you control the cursor from 
the keyboard and/or use a Mac one-handed. A com­
plete description appears on page 354 of Macintosh 

Reference, the manual that comes with System 7 
upgrade kits. 

Slimming The Size Of The Apple Menu 
Items Folder 
The Apple Menu Items folder contains the standard 
DAs. With the exception of the Chooser, you don't need 
any of the Apple-supplied DAs: Alann Clock ( 12K), 
Calculator (8K), Key Caps (12K), Note Pad (9K), 
Puzzle (14K), or Scrapbook (UK). On the other hand, 
they're small and relatively useful (except for Puzzle), 
so you needn't toss them unless you're really hard­
pressed for disk space. 

Rescuing The Size Of The System Ftle 
Take a look inside the System file itself (double­
click on it). The Installer places about a megabyte of 
fonts and sounds inside the System file, but you 
don't actually need most of them. If you're really 
determined to whittle down your System Folder, get 
rid of your least-used fonts (3K to 68K each) and 
sounds (2K to BK each). 

SYSTEM INSTALLER 
(SYSTEM 7) 
Customizing the Installer 
If you choose Easy Install, as most users do, the 
Installer will install48 files, many of which you will 
never need. If you try to remedy the situation by choos­
ing Customize, you're presented with a list of almost 40 
items. Here's how to navigate through this list: 

Choose the ones you want to install by Shift-clicking 
on them - hold down the Shift key while you scroll 
and click on each item you want installed. 1b find out 
more about an item, click on it and an explanation 
appears below the scrolling list. 

Custom Selecting A System To Install 
In the Custom Install dialog of the installer, there are 
three categories of software- system software, printer 
software, and file sharing/networking software. They 
are arranged in five sections in the scrollable list. 

System software is broken up into System Software for 
any Macintosh (the first choice on the list) or System 
Software for [a specific Mac model]. 
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System Software for any Macintosh installs everything 
you need to start up any Mac model from your hard disk. 
System Software for [a specific Mac] installs only the 
resources that model requires. So, for example, if you 
choose System Software for Macintosh Plus, control pan­
els such as Monitors and Colors are not installed. If you 
never expect to use your hard drive with a different 
Macintosh model, choose System Software for [your par­
ticularmodel]. But ifthere's a chance you'll someday 
need to use your hard drive with a different Mac model, 
choose System Sofware for any Macintosh. 

Creating A Bootable Floppy Disk 
The last section of the Custom Install dialog list 
contains a set of items called Minimal Systems. 
These are used only to create high-density (FDHD) 
startup floppies. (Even a minimal installation of 
System 7 is too big to fit on an 800K floppy.) 

Min System for any Macintosh creates a startup flop­
py that works with any Mac model. Min System [for 
a specific Mac] creates a startup floppy that works 
with that particular model. Minimal System installs 
a System and the Finder and little else- no control 
panels, extensions, or DAs. The Installer does place 
the standard five subfolders (Apple Menu Items, 
Extensions, and so forth) inside the System Folder, 
however, and it provides an empty Control Panels 
folder as aDA. (It also installs a single font, 9-point 
Geneva in the System file.) 

Installing Printer Drivers 
In the Custom Install section of the installer, there is a 
section listing printer files to install. You can selec­
tively choose which printer drivers to install­
LaserWriter, Image Writer, Personal LaserWriter LS, 
StyleWriter, and so on. Shift-click on each one you'll 
need. You also can choose Software for all Apple 
Printers, which automatically installs all eight drivers. 

Installing Network Software 
In the Custom Install section of the installer, there is a 
section listing the network files to install in the 
System folder. If you're on a network and will be shar­
ing files, Shift-click on File Sharing Software. If you'll 
be using an EtherTalk or Token Talk network, 
Shiftclick on those items as well. 
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TECHNICAL 
INFORMATION 
How To Get The Macintosh 'Iechnical Notes 
The Macintosh Technical Notes are a resource for all 
Macintosh developers. Every time there's a topic that 
seems to be perplexing the developer community, 
Apple's DTS (Developer Technical Support) prepares 
a note that will cover the situation in detail. When 
bugs are discovered in system software or in ROM 
code, Technical Notes that fully describe the prob­
lems and how to solve them are written and dis­
tributed. When there's no other way to distribute 
documentation on certain system software (such as 
ThachThxt), it's disseminated as a Technical Note. 

DTS wants its Notes to get the widest distribution 
possible, so all the more than 300 notes can be 
downloaded from many on-line services. You can 
also buy them on-disk or in printed form from APDA 
(800-282-2732). 

TRUETYPE (SYSTEM 7) 
Changing The System Font Default With 
SetOudinePreferred 
The Chicago 12 font is the only font that's actually 
burned right into the Macintosh's ROMs, and it's the 
default font for menus and title bars and all kinds of 
other cool stuff. Whenever the System needs Chicago 
12, it ignores any disk files and just gets the bit maps 
from ROM. 

Apple included a new set of Font Manager routines 
with TrueType. One of them, appropriately called 
SetOutlinePreferred, tells the system always to use 
the TrueType version of a font instead of the bit­
mapped version, including 12-point Chicago in 
ROM. (The TrueType version of Chicago contains 
both the full extended character set and a large 
number of extra characters, including the 
Command-, Option-, Shift-, Tab-, and Delete-key 
symbols.) 

This routine needs to be turned on, and you can do 
so with an Fkey called SetOutlinePreferred, created 



by David Fowler, of Cotati, California. This Fkey lets 
you force the TrueType version of a font to be dis­
played and printed in any appl ication. It's "smile­
ware" (you can distribute it freely) and is avai lable 
from Mac User's on-line service, ZiffNeVMac. 

You can install this and other Fkeys by using utilities 
such as ALSoft's Masterjuggler or Fifth Generation's 
Suitcase II, or you can use Apple's resource-editing soft­
ware ResEdit (available from on-line services and user 
groups). If you have ResEdit 2.1 or later installed, just 
double-click on the FICEY icon and ResEdit will launch. 
Double-dick on the Fkey resource, highlight the ID 
number, and press Command-C to copy the Fkey to the 
Clipboard. NO\V, open a copy of your Mac's System file 
(move the original System file to a safe place outside 
the System Folder), double-click on the Fkey resource, 
and press Command-V to paste in the Fkey. Rename the 
copy of the System file, place it in the System Folder, 
and restart your Mac. 

TrueType Symbols For Control Keys 
The True Type version of Chicago font that ships with 
System 7 has numerous special symbols. lb get the 
Command-key cloverleaf, type Controi-Q. Typing 
Option-Controi-Shift-D gives you a Shift-key sym­
bol. Likewise, Option-Control-Shift-A produces the 
Option-keys symbol. The latter two symbols are not 
in the bit map Chicago font that came with older 
Macs and previous system versions. 

Because a bit map font has priority over a TrueType 
font for screen display and output, you should remove 
any bitmap versions of Chicago that are in your System 
file if you need to use any of the Option and Shift sym­
bols. This allows them to display and print properly. 
Furthern1ore, a 12-point bit map version of Chicago is 
built in to the Mac's ROM, so you won't be able to use 
the Shift and Option characters at that size. 

These symbols may not print properly in some appli­
cations, but they do appear on-screen. 

VIRUSES 
Virus Protection Across A Network 
If someone on your network has mounted your hard 
disk as a remote volume, it's possible that your disk 
could become infected by a virus on that person's hard 

disk, transmitted through the network. f'Or this rea­
son, any attempt at virus protection has to be applied 
to all the Macs on the network in order to be effective. 
Of course, if you install virus protection on every net­
worked Mac, you'll eliminate the problem entirely. 

UTILITIES 

32·BIT ADDRESSING 
Go 32-Bit Clean 
If you have a Mac II, Ilx, !lex, or SE/30 and run 
System 7, you may have heard that your computer's 
not 32-bit clean, which means that you can't take full 
advantage of System 7 features such as virtual memo­
ry. lb correct this problem, Apple bought MODE32, an 
extension from Connectix that adds 32-bit-addressing 
capabilities to these computers. Apple is giving 
MODE32 away through dozens of on-line services, 
BBSs, and user groups. f'Or more information, call 
Apple Customer Service Center at 800-776-2333 or 
( 408) 996-1010. 

ACCESSPC 
System 7 Invisible Files 
If you are using Access PC under System 7, and have 
mounted a DOS disk, you will find files created with 
names li ke DESKTOP&. 

What's happening is System 7.0 creates invisible fold­
ers and files as part of its nom1al operation. 1\vo such 
folders, called Trash and Desktop Folder, are created 
on every hard disk that is mounted on the Mac desk­
top. AccessPC lets you mount DOS disks as though 
they were Mac disks. 

But DOS allows only eight characters in a file name, 
so longer names (such as Desktop Folder) get truncat­
ed; AccessPC adds the trailing ampersand to indicate 
that the truncation has occurred. 
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ADD/STRIP 
Powerful File Filter And Converter 
Jon Wind's Add/Strip shareware application is a file fil­
ter that combines powedul conversion options, such as 
converting spaces to tabs, up to nine strings of charac­
ters to replacement strings, cleans up spaces, blank 
lines, double hyphens to em dashes and much more. 

Add/Strip also has built-in tables for conversion 
between DOS and Macintosh text fom1ats and a 
encryption/decryption system. Add/Strip is available 
on ZiffNeVMac and your local user group. 

AFTER DARK 2 
Editing The MultiModule 
Even After Dark 2's extensive collection of modules 
can fail to stimulate after a while. But the screen 
saver's MultiModule allows an amazing amount of 
customization without you having any programming 
knowledge whatsoever. One of my favorites is Stom1y 
Skyline. To tum Stormy Skyline into one hell of an 
electrical storm, simply follow these instructions: 

1. Duplicate the Zot! module twice while you're at the 
desktop, renaming the copies Zot!2 and Zot!3. 

2. Open the MultiModule to Stormy Skyline (a prede­
fined combination of Starry Skyline and Zot!), and 
click on the Edit button. Add Zot!2 and Zot!3 to this 
MultiModule, making them transparent instead of 
opaque. You should now have all three of the Zot! 
modules and the Starry Skyline module combined. 

3. Resize and reposition the Zot!s- it looks better to 
have them different sizes. 

4. Close the edited Multi Module, but first rename it 
something like Really Stormy Skyline. 

5. Open the individual Zot! modules, and edit the fork­
iness, kinkiness, and delay of each. 
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ALIAS 
Aliases Anonymous 
It doesn't take much effort to create aliases. You do, 
however, have to go through a few steps to create an 
alias and then put it where you want it. Wouldn't it 
be nice to have a one-step method of creating an 
alias and placing it anywhere on your hard disk? Well, 
Mac User has just the thing for you- it's 
Nom de Plume, developed exclusively for Mac User by 
Birmingham, Alabama, programmer Bill Monk, who 
also created Alias Assassin. 

Nom de Plume is a utility that lets you create an alias 
of a file, folder, or disk and choose its location on the 
hard drive from within one dialog box. Nom de Plume 
makes it so easy to create aliases that you'll probably 
need Alias Assassin before too long to get rid of your 
excess aliases. Luckily, both of these utilities are avail­
able on MacUser's on-line service, ZiffNeVMac, in 
Library 3 (Utilities) of the MacUser Forum. Nom de 
Plume's filename is PWME.Sit If you want to find 
Alias Assassin, its filename is ALIASASIT. 

Alias Assassin 
Aliases are a mixed blessing. Aliases are duplicate 
icons for files, folders, and volumes that are linked to 
an original file. Unfortunately, when you delete a file, 
the aliases remain, so you could easily have a hard 
disk full of aliases relating to nonexistent files. 

Apple hasn't provided an easy way of getting rid of 
''orphaned'' aliases, which is where Alias Assassin 
comes in. Alias Assassin, an application developed 
exclusively for Mac User, seeks out and destroys 
orphaned aliases. It scans your hard disk to find all 
unattached aliases and lets you choose whether the 
orphans should be trashed. If you have aliases relat­
ing to unmounted volumes, Alias Assassin asks you to 
mount the volume to confirm whether it still exists. 

Alias Assassin is smart. It attempts to reunite an alias 
with its parent file, even if the path between the two 
has been lost because you've shuffled files around on 
your hard disk. And if you're fed up with aliases entire­
ly, Assassin can kill them all at your discretion. 

Alias Assassin was programmed by Bill Monk, of 
Birmingham, Alabama. Alias Assassin can be found 



only on ZiffNeVMac, .Mac User's on-line service on 
CompuServe. The filename is AliasA.sn: and it's in 
Library 3 (Utilities) of the Mac User Forum or Library I 
(Applications) of the Download & Support Forum. 

Automate Your Aliases 
Nearly a dozen utilities can creat aliases. Here's a sam­
pling of the coolest. AKA (Fred's Finder Hacks) creates 
an alias when you control-drag an icon to a new fold­
er. Mac User's Nom de Plume, available on ZiffNet/Mac, 
creates an alias and automatically puts it into com­
mon folders such as the Apple Menu Items folder. 
MacUser's ZMakeAlias creates aliases from within an 
application's Save and Save As dialog boxes. 

Clean Up Alias Ftles 
Making aliases is a lot easier than getting rid of them. 
When you trash a file, its alias remains. Mac User's 
Alias Assassin combs through your hard disk, search­
ing for unattached aliases. A list displays the orphans, 
and you have the option to delete them or reattach 
them to lost files. TrashAlias, a freeware extension, 
provides a more automated solution. When you throw 
away a parent file, the alias follows it into the Trash. 

Load Extensions With Aliases 
You're out of luck if you want aliases to load exten­
sions that aren't kept in the System Folder, unless you 
have the freeware utility INITI.oader. INITI.oader even 
lets you load extensions across a network- a boon 
for network managers who want to keep everyone 
up-to-date on virus-detection extensions. 

ALARM CLOCK 
Get Message Alarms 
If you need to be reminded of impending appoint­
ments, then go a step further than Apple's Alann Clock 
with one of the many alann utilities. 

The shareware application CClock ( CClock, 2655 
S. Peoria, Aurora, CO 80014) alerts you with a cus­
tomized message when an alann sounds. Alarm Clock 
(Now Utilities, Now Software, Inc., 520 S.W. Harrison, 
Suite 435, Portland, OR 97201; 800-237-2800) 
and Easy Alanns let users enter alarm items that can 
repeat every hour, day, week, and so on. Alanning 
Events (CE Software, Inc., 1801 Industrial Circle, 

PO Box 65580, West Des Moines, lA 50265; 
800-523-7638) is a full-featured DA that adds 
detailed alann messages and a calendar. 

AMT 
One-Stop Modem-Tool Customization 
Information Electronics of Hammondsport, N.Y., has 
released a nifty, free utility for users of Apple's 
Macintosh Communications Toolbox. AMT Configure, 
a 38-Kbyte program available through on-line ser­
vices, lets you edit the modem initialization strings 
stored inside the Apple Modem Tool. 

Apple's tool lets you set custom strings, but each string 
you enter is tied to a particular use of the tool. You 
need to recreate your custom string in each applica­
tion or electronic-mail gateway that uses the tool. 
AMT Configure alters the resources of the tool itself, 
making your changes universal. With AMT Configure 
and knowledge of the modem's command set, you 
could, for instance, tum off a specific type of modem's 
speaker or tlow control. 

Version Note: AMT Configure 1.0 does not work with 
the Apple .Modem Tooll.l. 

APPLICATIONS 
Lauch Applications From Anywhere 
System 7lets you launch applications and documents 
from the Apple menu. HAND-Off II and MultiMaster 
(Now Utilities, Now Software, Inc., 520 S.W Harrison, 
Suite 435, Portland, OR 97201; 80{}-237-2800) let you 
launch files from anywhere on-screen through a pop­
up menu. HAND-Off II also includes a powerful set of 
hot keys for launching documents and programs. 

BACKUP 
CrashproofYour Data 
Your infonnation is only as safe as your last save. 
However, Last Resort (Working Software, PO Box 
1844, Santa Cruz, CA 95061; ( 408) 423-5696) gives 
you a second chance in the case of a system crash. 
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This unique utility saves every keystroke you type as 
you type it, saving everything to a text file, including 
symbols for such actions as a deletion or a backspace 
keystroke. If your system crashes, you can rebuild 
your document from the backup file. A new text file is 
created every time you tum on your computer. 

Back Up Data Continuously 
Increasingly, users are turning toward automatic 
backup systems that mirror their main disk as they 
work. These systems are extra safe and make it like­
lier that you'll get nearly all your files back after the 
inevitable crash. Auto Back (TerraNetics, 1538 N. 
Martel Avenue, Suite 413, Los Angeles, CA 90046; 
[818] 446-7692) and Twin-It (Golden Triangle, 
Computers, Inc., 4849 Ronson Court, San Diego, CA 
92111; [619] 279-2100) both give you the luxury of 
duplicating your disk on a second hard disk as you 
work. 

BACKUP SOFTWARE 
Why Doesn't Tune Stamp Work On Backups? 
Each Mac volume has a "date and time of last backup" 
parameter that's created when the volume is initialized. 
While a few backup programs set this date whenever 
you perform a backup, most newer software doesn't. 

This is not as bad as it seems, though. Modern backup 
software lets you pick and choose what to back up, so 
a single time stamp doesn't make that much sense 
anymore. All modem backup programs keep track of 
the date and time of the last backup internally. 

BALLOON HELP 
Use A Hot Key For Balloons 
On-screen Balloon Help is a good idea that is abun­
dantly annoying. Turning on Show Balloons activates 
every balloon your cursor travels over How many 
times do you need to be told what a menu bar is? 
Helium (Robert L. Mathews, PO Box 21271, Oakland, 
CA 94610) inflates Help Balloons when you hold down 
a hot key. Letting go of the key deactivates Show 
Balloons. 
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Hide The Balloon Icon 
If you are so frustrated by Balloon Help that youtl 
rather be rid of it altogether, then get 
NoBalloonsMenu, a freeware extension that removes 
the icon from the menu bar, thereby freeing up space 
on the right-hand side for other menu enhancements. 

BBEDIT 
The Programmer's Word Processor 
A word processor is not usually the best tool when you 
are writing source code for an application, converting 
files from one format to another or working with typi­
cal on-line information services. 

For such purposes, a text editor, one of those bare­
bones programs from the old days of graphics-free 
computing, is still a useful tool, even on the 
Macintosh. Fortunately, the humble nature of these 
applications has kept prices down. BBEdit, a great edi­
tor, is a freeware product. 

The program has plenty of programming features, 
such as balancing of parentheses, multifile searches 
and compatibility with such other tools as Macintosh 
Programmer's Workshop. What gives BBEdit a real 
kick, though, is grep, a sophisticated pattern-match­
ing and replacement language derived from Unix. 
It's already implemented on the Mac, in Paragon 
Concepts Inc.'s QUED/M and Nisus, but not at BBEdit's 
bargain price. 

The program and documentation are available from 
user groups and on-line services, including 
ZiffNeVMac, where they are compressed in file BBED­
IT.CPT in Library 1 at GO ZMC:DOWNLOAD. 

Siegel also accepts stamped, self-addressed mailers 
sent to the address listed belO\v. Include a floppy or $2 

Richard Siegel is at 6 Village Way, No. 23, Natick, Mass. 
01760. E-mail siegel @ world.std.com. 



CALCULATOR 
(SYSTEM 7) 
Customize Your Calculator 
The calculator that ships with System 7 hasn't 
changed its interface since the Mac was introduced, 
but a bevy of more complex calculators offers specific 
features geared toward the type of number crunching 
you do most. Desktop publishers and designers 
should check out Calc+ (Abbott System, Inc., 62 
Mountain Road, Pleasantville, NY 10570; 
800-552-9157), a calculator with an easy-to-use 
interface and the ability to automatically convert 
among different units of measurement such as picas, 
inches, and centimeters. Scientists and engineers will 
want to add RPN (reverse Polish notation) Calculator 
or Sci Calculator (both part of File Director). Each 
adds a host of functions and modes you're likely to 
find in a midlevel stand-alone calculator. As the 
name implies, 2000 Digit Calculator displays as 
many as 2,000 places for a calculation. 

CALENDAR 
Use A Desktop Calendar 
If you want a date keeper for your desktop, try out 
Calendar DA, a shareware DA that goes well into the 
next millennium. This monthly calendar has a 
notepad for each day. The commercial DiskTools 
Calendar (File Director, Fifth Generation Systems, 
10049 N. Reiger Road, Baton Rouge, LA 70809; 
800-873-4384) offers a similar layout and also has a 
Find command and the ability to archive daily notes. 

COLOR 
Color Your Menus 
Even with a color monitor, the Mac still ships with dull 
black-and-white system software. ClickChange (Dubl­
Click software, INc., 9316 Deering Ave, Chatsworth, CA 
91311; [818] 700-9525) and the shareware application 
Colorize add hue and shade to the common desktop. 
These applications color the Mac's basic elements-

such as windows, menus, dialog boxes, and scroll bars 
-with any of the Mac's 16.7 million available pig­
ments. ClickChange also replaces the Mac's factory­
issued cursor with something different, such as an 
index finger or a pointer of your own creation. 

CURSORANIMATOR 
Animating Your Cursor 
Remember how gee-whiz exciting it was when Apple 
first introduced animated wait cursors like the rotat­
ing watch and the spinning beach ball? You can 
recapture that excitement all over again and then 
some with CursorAnimator from Wilhelm Plotz and 
Alex Falk. 

CursorAnimator is a freeware control-panel/INIT 
combo that allows you to substitute various animated 
or static color and black-and-white cursors for any of 
the standard Apple system cursors (text insertion, 
crosshairs, plus sign, watch, and the arrow). The con­
trol-panel interface permits you to choose the cursors, 
import new CursorAnimator cursors you download 
from on-line services or create yourself, change the 
speed of animated cursors, and delete cursors you no 
longer want. 

Cursor Animator comes with several cursors pre in­
stalled. Changing the standard cursors is easy. You sim­
ply drag the new cursor from a scrolling list to a grid 
beneath representations of the standard system cursors. 
To create your own cursor, you must delve into the mys­
teries of ResEdit 2.1 or higher. CursorAnimator includes 
an extension for ResEdit that allows you to preview ani­
mated cursors while in ResEdit. And if you find ResEdit 
too intimidating, you' II be happy to discover that 
CursorAnimator comes with a collection of 27 black­
and-white and 23 color cursors you can import. There 
are even six cursors provided just for lefties. 

DESKTOP PRINTERS 
DTPrinter 
Desktop Printers were originally supposed to be part of 
System 7, but they dropped out along the way. Now the 
same idea is back with DTPrinter, a freeware extension. 
Desktop Printers are icons that represent various print-
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ers on a network. Drag a document or folder onto the 
icon to print from the Finder. 

DIALOGS 
Mouseless Dialog Boxes 
Keep your hands on the keyboard when dialog boxes 
pop up, with one of these three solutions. DialogKeys 
(QuicKeys 2, CE Software, Inc., 1801Industrial Circle, 
PO Box 65580, West Des Moines, lA 50265; 
800-523-7638) lets you cycle through buttons in a 
dialog box with Command-Tab. 

Dialog Power! ( QuickTools, Advanced Software, 1092 E. 
Duane Ave, Suite 103, Sunnyvale, Ca 94086; 
800-346-5392) and the Freeware extension Escapade 
assign a letter to a dialog-box button as the 
Equivalent of a click. Dialog Power! also lets you cut, 
copy, and paste into any dialog box- very handy if 
you're transferring information. 

DISK FIRST AID 
A Hidden Command 
Disk First Aid contains a hidden command that offers 
more information about the program's operations. 
Press Command-S after opening a disk in Disk First 
Aid, and a scrolling field appears below the normal 
dialog box. This field displays a list of actions per­
formed by Disk First Aid as they are executed. 

DISKSWITCH (SYSTEM 7) 
Switching Drives 
Some software upgrades sacrifice familiar features for 
new concepts. Take, for example, the Drive button in 
the System 6 Save dialog box. The Drive button lets 
you choose where to save a file by conveniently 
switching among mounted hard drivers, floppy drives, 
and AppleShare serves. 

In System 7, however, Apple replaced that button with 
one that takes you straight to the desktop, where you 
can view all volumes and folders simultaneously. An 
improvement? Yes, but some users now must perform 
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two operations, instead of one, to switch drives. 
Mac User's DiskSwitch utility adds an icon to all Open 
or Save dialog boxes; click on the icon, and you get a 
pull-down menu that lets you quickly select any flop­
PY drive, hard drive, Apple Share server, or other 
mounted volume without going through the desktop. 

DiskSwitch was programmed by Mike Throckmorton, 
an Ann Arbor, Michigan-based developer. DiskSwitch 
is available exclusively through ZiffNet/Mac, 
MacUser's on-line service. Look for DSKSWT.CPT in 
Ubrary 3 (Utilities) of the MacUser Forum or Ubrary 3 
(INITs) of the Download & Support Forum. 

DOS MOUNTER 
Initializing A Disk Across A Network 
If, when trying to mount a shared volume across the 
network, your Mac asks if you want to initialize the 
disk, you're probably running an old version of Dayna 
Communications Inc.'s DOS Mounter. DOS Mounter is 
an extension that enables you to read data off DOS 
disks in your SuperDrive-equipped Mac. Early versions 
conflict with System 7.0's file sharing. Contact Dayna 
at (801) 972-2000 for an upgrade. 

ENDNOTE PLUS 
'fracking Ftgure And 'Jhble Numbers 
EndNote Plus is wonderful for keeping a list of refer­
ences for a document, but it would be even better if it 
could keep track of figure and table numbers for a 
report. 

You can add this ability by copying the EndNote Plus 
application onto your hard disk. For references, figures 
and tables, you'll need two extra copies. Name the new 
versions EndNote B and EndNote C. These copies of 
EndNote Plus need to use unique characters to mark 
the temporary citations in your document. EndNote 
Plus stores these characters in a preferences file in the 
System Folder, so you must use ResEdit to rename the 
preference files the copies use. 

Open EndNote B in ResEdit, and open STR# resource 
number 128. The eighth string in this resource is the 
name of the preferences file. Change it from EndNote 



Prefs to EndNote B Prefs, and save it. Make a similar 
change for EndNote C. 

Next, launch EndNote B and select Citation Markers 
from the Edit menu. Change the markers from [and] 
to {and}. Similarly change the citation markers in 
EndNote C to < and >. 

Now, when you're writing your document, create a ref­
erence-list file in EndNote Plus, a figure-list file in 
EndNote B, and a table-list file in EndNote C. When 
the time comes to fonnat your document, open your 
base document in one copy of EndNote and fonnat it, 
open the first fonnatted document in the next copy of 
EndNote and fonnat it, and open the second fonnatted 
document in the third copy of EndNote and fonnat it. 
You can then open the final fonnatted document in 
your word processor and move the figure list and table 
list to wherever you want them. 

This workaround sounds quite complicated, but it's 
really not that bad once you start using it. The 
EndNote Plus application exists quite happily in a 
512K memory partition, so your three copies occupy 
about 1.5 megabytes of memory. Obviously, you can't 
do this on a !-megabyte Mac Plus, but it works well on 
an 8-megabyte Mac Ilcx. Each additional copy of 
EndNote Plus occupies 321 K of hard-disk space plus 
5K for the preferences file. 

EXTENSIONS 
Managing Extension Conflicts 
The only problem with extensions is that it's some­
times impossible to get them all to work together. 
Some conflicts may result in system crashes unless 
you pull the extension out of the System Folder. The 
freeware utility Extension Manager provides a 
checklist of extensions you can toggle on or off at 
startup or through a control panel. If you want 
more features, look to commercial products such as 
INIT Manager (BaseLine Publishing, 1770 Moriah 
Woods Blvd., Suite 14, Memphis, TN 38117; 
800-926-9677), !NITPicker (Microseeds 
Publishing, Inc., 5801 Benjamin Center Drive, Suite 
103, Tampa, FL 33634; [813] 882-8635), or StartUp 
Manager (Now Utilities, Now Software, Inc., 520 S.W. 
Harrison, Suite 435, Portland, OR 97201; 
800-237-2800). With these utilities, you can define 

and load groups of extensions that work with one 
another or make extensions dependent on each other. 

EXTENSION 
MANAGER 1.6 
Managing Extension Manager 
Apple's Extension Manager 1.6 utility lets you take 
care of extensions and control panels, but you can 
also use it to manage other items that are loose in 
your System Folder, such as applications, startup 
sounds or screens. Here's how: 

Open the Extension Manager control panel, click on 
the button labeled 1.6, and then click on the button 
labeled Configure. This brings up a window that lets 
you add new file types to Extension Manager's 
scrolling list of what's in your System Folder. You can 
find out what a file's type extension is by using 
ResEdit or a utility such as DiskTop. 

Here are a couple of ways to use this feature: 

1. Add the file extension for applications (APPL) to the 
lower list in the Configure dialog box (just ignore the 
upper list). Applications you have in the System Folder, 
such as PrintMonitor, will now show up in the list on 
Extension Manager's initial screen, letting you tum 
them on or off. 

2. Control the contents of your Startup Items folder by 
storing aliases of the programs and files you want to 
open on startup, rather than the programs themselves. 
By adding adrp (the type extension for a file alias) 
and fdrp (the type extension for a folder alias) to 
Extension Manager's list on the initial screen, you can 
disable these aliases if you don't want a particular 
program to open on startup. 

FILES 
Create Ftle Work Sets 
If you want to open multiple documents simultane­
ously, get Out to Launch, a freeware Fkey that lets you 
define groups of documents of the same type to launch 
at one time and lets you define "work sets" of multiple 
applications and documents that can be launched 
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with one command. HAM (Hierarchical Apple Menus, 
Microseeds Publishing, INc., 5801 Benjamin Center 
Drive, Suite 103, Tampa, FL 33634; (813) 882-8635) 
has the ability to take snapshots of open documents 
and store them as a work set, which can be launched 
later. Tiles is the most feature-laden application in this 
group. It manages dozens of work sets easily. 

Preview Graphics Files 
The process of opening a graphic from within a paint­
ing, drawing, or page-layout program can be time­
consuming. Screen redraws and color files combine to 
make the process slow. Opening the wrong file is even 
more frustrating. PickTURE (Right Answers, Box 
3699, Torrance, CA 90510; (310) 325-1311) solves the 
problem by letting you preview thumbnail graphics 
from within the Open dialog box, which gives you an 
idea of what the image looks like. 

Launch Files With Substitute Applications 
One of the more annoying dialog boxes is 
"Application not found," which you get when you 
double-click on a file in the Finder for which you 
don't have the application. 

Jump Start, a shareware program (Insanely Great 
Software, 126 Calvert Avenue E., Edison, NJ 08820), 
launches documents with a substitute program. For 
instance, it automatically launches Mac Write docu­
ments with Microsoft Word, or vice versa. HAND-Off I I 
(Connectix Corp., 2655 Campus Drive, San Mateo, CA 
94403; 800-950-5880) is the commercial alterna­
tive, and it adds a host of features - not the least of 
which is the ability to launch DOS documents. 

Get A List Of Recently Opened Files 
You usually don't realize that a file has been lost until 
you have the Open File dialog box on-screen. Shortcut 
and Super Boomerang (Now Utilities, Now Software, 
Inc., 520 S. W. Harrison, Suite 435, Portland, OR 97201; 
800-237-2800) build lists of commonly used files 
and folders so that you can easily "jump" to a differ­
ent folder from within the Open and Save dialog 
boxes. Super Boomerang is the stronger utility, but it 
comes at a higher price, because it's grouped with 
other applications. 
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FILE COMPRESSION 
Automatically Compress Files 
Hard disks may be getting larger, but so are files. Here 
are two programs to help keep your disk from over­
flowing by compressing files when you're not using 
them. DiskDoubler (Salient Software, 124 University 
Ave, # 103, Palo Alto, CA 94301; [ 415] 852-9567) puts a 
Compress File menu onto the Finder so that you can 
highlight files and squash them down to half their 
size. SuperDisk (Alysis, 1231 31st Avenue, San 
Francisco, CA 94122); [415] 566-2263) automatically 
compresses files or folders saved with the suffix.s. 

Compressed Mac 1b PC And Back 
If you worked in a mixed environment, Macs and PCs, 
you will eventually run into compressed files: primar­
ily ZIP or ARC archives on the PC side, and SEA, SIT, or 
CPT archives in the Mac domain. 

Without compression, graphics files, especially TIFFs, 
can be mammoth in size and must frequently be com­
pressed to shorten modem transfers to within one per­
son's lifetime or to make the file fit onto one floppy. How 
does a Mac user deal with ZIP or ARC files? Or a PC user 
with SIT and CPT archives? R>rtunately, there are some 
commercial and shareware/freeware solutions. 

Macintosh users stymied by an ARC or ZIP archive can 
tum to a couple of shareware or freeware programs: 
ArcMac or UnZIP. Both are available from the major 
on-line services. Both are older programs and may not 
always work on some ZIP or ARC files. If you own 
Stufflt Delux, a commercial Mac compression utility, 
you'll find it has menu commands for deARC-ing or 
UnZIP-ing archives. The program isn't free, but it's 
very dependable when it comes to PC-compressed 
files. 

DOS users, confronted with a SIT or CPT archive from 
a Mac colleague, can use either UnSIT or ExtractorPC 
to delve into Mac Stufflt (SIT) or Compact Pro (CPT) 
archives. Some caveats need to be heeded, however. 
SIT or Stufflt files come in a couple of flavors, since 
Stufflt exists both as a commercial product (Stufflt 
Deluxe) and as a shareware utility (Stufflt L5.1 or 
Stufflt Classic). UnSIT will only process SIT files saved 
in the 1.5.1 format. If you find yourself with a Stufflt 
Deluxe or Classic file, you're stuck. Luckily, both 



Stufflt Deluxe and Classic can save in the 1.5.1 format. 

The other chief Mac compression archive a PC user 
will encounter is one created with Compact Pro 
(a.k.a. Compactor). The file extension is usually CPT. 
Compact Pro's author, Bill Goodman, has himself pro­
vided a solution- Extractor PC. It extracts not only 
CPT archives, but also SEA (Self-Extracting Archives) 
files created on the Mac with Compact Pro. Stufflt 
Deluxe also generates SEA archives, but ExtractorPC 
will not process them. 

Generally speaking, try to avoid compressing files to 
be transferred unless it's absolutely necessary. If you 
must use compression, make sure the recipient can 
handle your method. 

FILE CONVERSION 
'Ihlnsporting PC TIFF Ales To The Mac 
TIFF (Tag Image File Format) is one of the best and 
most troublesome formats for transferring PC-based 
raster or scanned graphics to the Mac. TIFF is widely 
supported in both the Mac and PC environments, but 
the format differs on the Mac and PC which leads to 
some curious problems. 

Simply bringing a PC TIFF file over to the Mac can be 
quite frustrating at first. If you try to open a TIFF cre­
ated on the PC in a Mac graphics program, you're like­
ly to receive an error message telling you the program 
encountered an unexpected end-of-file error. What 
you need to do is run the file through Macintosh con­
version software, like MacLinkPlus/ Translators, 
before graphics programs will even take so much as a 
sniff at your TIFE 

Adobe PhotoShop and Deneba Canvas (for the 
Macintosh) can translate foreign graphics through an 
impressive variety of file filters that enable you to 
open, import, and edit graphics carried over from a 
different platform. 

If you don't want to do any editing with another pro­
gram, you' 11 discover that Aldus PageMaker 4.1 
imports PC TIFFs without prior processing or conver­
sion. This feature can speed up the layout cycle, 
although the PC TIFFs often import at about 25 per­
cent of their original size, making resizing necessary. 

'Ihmsporting Mac TIFF Files To The PC 
On the PC, Do DOT (Windows-based and raster or 
bitmap images only) from Halcyon and Hijaak (DOS, 
raster, and vector formats supported) from Inset 
Systems, are two screen-capture utilities for PCs that 
do double duty as graphics converters. There is dedi­
cated file-conversion software for the PC, such as The 
Graphics Link Plus+ from Harvard Systems, but for 
most mainstream graphics formats, such as EPS 
(Encapsulated PostScript), PCX (Paintbrush), PICT 
(Mac format), and TIFF (Tag Image File Format), you 
may find dedicated products unnecessary. 

Bringing Mac TIFFs· over to the PC does present some 
problems. PC programs like DoDOT or CorelDRAW! 
refuse to recognize Mac TIFFs saved with LZW com­
pression. Uncompressed Mac TIFFs, however, open or 
import quite well without prior massaging in a con­
version program. PC users should make sure that 
their video card and driver is supported and set to 256 
colors when working with color TIFF files. Otherwise, 
the imported TIFFs will appear distorted and substan­
dard. Likewise, Mac users should set the monitor's 
control panel to 256 color or grays for best results 
when viewing or editing TIFFs. 

'lhlnsporting EPS Ales To Macs And PCs 
EPS (Encapsulated PostScript) is nearly omnipresent 
on the Mac (and making considerable inroads in the 
DOS/Windows world); serious Macintosh graphics, 
especially good clip art, nearly always come in the 
form of EPS files. Suppose you want to bring Mac EPS 
clip art over to the PC? 

The answer is fairly simple. When an EPS Mac file is 
opened in a program like CorelDRAW! on the PC, you 
can even perform edits (modify colors, line widths, 
etc.). Here's a tip that will spare you some grief: 
CorelDRAW! will usually connect with just about any 
Mac EPS file you care to throw at it, but it fails some­
what more frequently with EPS files exported from 
Aldus FreeHand. 

Adobe Illustrator EPS works a bit better. CorelDRAW! usu­
ally works well with Illustrator files saved on the Mac in 
1.1 or 3.2 format with or without the PC Preview option 
selected It imports files saved with the Mac preview with­
out a shudder. But CorelDRAW! can sometimes choke 
even on Illustrator EPS with the alert thatthe file is too 
complex. Th almost always work around this, go back to 
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the Mac and save the file in the Illustrator 1.1. format 
with tl1e PC Preview option turned on. 

If you plan to bring the Mac graphic into a non­
graphics program, like Word for Windows 2.0, you'll 
quickly discover that they strike out on straight Mac 
EPS files. You must either translate the files within 
CoreiDRAW!, or export them from Illustrator or 
FreeHand with the appropriate PC Preview 
(Illustrator) or MS-DOS option (FreeHand) selected. 

EPS Files Containing Fonts 
If an EPS file contains text elements and the file is 
being used on a Mac and PC, make sure that both the 
PC and the Mac platforms have the same PostScript 
fonts installed. If not, you may find text strings miss­
ing in the graphic. 

If, for some reason, the same fonts aren't available on 
both machines, it's fairly easy to work around the prob­
lem. On the Mac side, you can use Adobe Illustrator's 
Create Outlines command to convert selected text 
strings into objects. TI1e font issue then becomes moot. 
Aldus FreeHand offers a similar function. 

If an EPS file is traveling from the PC to the Mac, you 
can rely upon PC-based CorelDRAW!'s Convert to 
Curves command in the same way. TI1is trick only 
works if the amount of text is relatively small-some 
legends or titles, perhaps. And it generally works better 
if the point size of the text is over 12 points. 

Another ruse is to open the EPS file in a program that 
can export as TIFF. The letters become part of the 
raster image and cease to be text. PhotoShop, Canvas, 
and CorelDRAW! all enable you to do this. 

GIF Converter 
The GIF file format is a graphical format originating 
from Compuserve. CompuServe offers tens of thou­
sands of GIF (Graphic Interchange Format) images in 
various forums throughout the service. This raster or 
bitmap fonnat is more well-known in the PC environ­
ment, but Mac users are depriving themselves of a pre­
cious and ready resource of graphics clip art and scanned 
images if they don't know how to access and use it. 

Fortunately, there's an outstanding Mac $40 shareware 
product and called GIF Converter that can handle GIF 
files (and many other raster graphics formats as well). 
It's available on all major on-line services. 
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Converting PCX And BMP Ftles 
1\vo common PC bit map formats are PCX 
(Paintbrush) and BMP (Windows bitmap) can be 
converted over to the Mac. When bringing BMP or PCX 
graphics from the PC over to the Mac, you'll probably 
either need to convert them into a Macintosh format 
on the PC or use a conversion program like 
MacLinkPlus/ Translators (MacLinkPlus/PC Data 
Viz, 55 Corporate Drive, Trumbull, CT 06611; 
(203) 268-0030; $199) to get the job done on the 
Mac. Adobe's PhotoShop, the "universal graphics 
translator" for the Mac, can handle PCX files through 
its Acquire command. BMPs require reprocessing in a 
separate conversion utility like MacLinkPlus before 
they can be used in Mac programs. 

Converting MacPaint Files To The PC 
To take a graphic saved in MacPaint file fonnat to a 
PC, you can transfer it over and convert it on the PC 
using the PC-based Do DOT in Windows; The Graphics 
Link Plus+ and Hijaak likewise come to the rescue 
from the DOS command line. 

Do DOT's MacPaint to PCX filter doesn't always func­
tion well if you're planning to do any editing in 
Paintbrush -the image opens as solid black. If you 
experience difficulties in this way, save the MacPaint 
file in the BMP format instead and the PC-based 
Paintbrush will handle it without a burp. And if you 
simply want to place the PCX-ed MacPaint graphic 
into a word processor or page-layout program, the 
DoDOT MacPaint-PCX conversion works fine. 

Converting PC CGM Files To Macintosh PICT 
The PC world is awash in CGMs (Computer Graphics 
Metafiles). How does a Macintosh user bring them 
over to the Mac? 

Unfortunately the CGM standard is not very standard, 
with different CGM "dialects" being generated accord­
ing to the program that created them. Once you final­
ly bring a CGM file over to your Mac, there are several 
options. 

The Mac program MacUnkPius/ Translators (from 
Data Viz) easily handles CGMs exported from Harvard 
Graphics and Lotus Freelance, but handles other CGM 
files poorly. Deneba's Canvas 3.0 draw program pro­
vides a CGM import filter that's fairly speedy on the 
import, but slow on the save. It opens CGM files well, 
but saves them as huge PICT files that can be 10 to 15 



times bigger than the original CGM file. 

The best solution for many Mac users is a small $179 
program called MetaPICT from GSC Associates that 
makes good on its promises to convert almost any 
CGM file into a PICT file on the Macintosh. The pro­
gram's ugly DOS-like interface will be jarring to the 
Mac user, but it gets the job done, bringing even com­
plex, poorly parsed CGM files over to the Mac quite 
well. One caveat: It sometimes creates lines that are 
too thick {1-point where hairline would be better), but 
this can be easily corrected by opening the converted 
PICT in a Macintosh draw program, selecting all, and 
applying a hairline width. This added step greatly 
improves CGMs converted with MetaPICT. 

One thing you should keep in mind when doing CGM 
to PICT conversions is that you will not, for the most 
part, be able to do any extensive editing of the PICT 
conversion, regardless of whether you use Canvas, 
MacLinkPius/Translators, or MetaPICT. Complex edit­
ing issues should always be resolved on the PC side 
before a file is ported to the Mac. 

FIND (SYSTEM 7) 
Get A List Of Found Hies 
The System 7 Find command lacks one critical ele­
ment - a list of found files. Several programs (some 
old and some new) have stepped in to fill the void. Mr. 
File builds a list of found files from which you can 
launch, copy, and delete files. DiskTools and 
MasterFinder (File Director) are faster alternatives 
with more search criteria, such as by file size and 
modification date. 

Add Your Own Command-Key Shortcuts 
Have you ever wanted a Command-key shortcut for 
Empty Trash or another Finder menu item that doesn't 
have one? The shareware program Finder 7 Menus! 
allows you to choose a menu and define a key without 
having to resort to ResEdit (Apple's powerful but tricky 
resource editor). 

Instandy Access The Comment Held 
The Get Info box in the Finder lets you add comments 
to a file, but those comments are relatively useless 
unless you are in the habit of having dozens of Get 
Info boxes open. The freeware utility SFComment 

makes the comment field instantly accessible by dis­
playing file comments in the Open dialog box of any 
application. 

FINDER 7 MENUS! 
If You Don't Want To Use ResEdit 
If you don't want to dirty your hands with ResEDit, 
check out Adam Stein's shareware program Finder 7 
Menus! You can download a demo version from 
Mac User's on-line service, ZiftNetMac, and other on­
line services and user groups, or you can send $11 to 
Stein at 126 Calvert Avenue E., F.dison, NJ 08820. 
Finder 7 Menus! lets you change Command-key com­
binations or add them to the menus of the System 7 
Finder without ResEdit. 

It's an easy-to-use little application- just double­
click on it, and open a copy of the Finder. The File, 
Edit, and Special menus appears. Enter a key, press 
OK, and quit. Now move the modified copy of the 
Finder into the System Folder, and reboot. That's all 
there is to it. 

FKEYS 
Install Your Own Fkeys 
Lots of great Fkeys are available for the Mac. The prob­
lem is that there's no easy way to install them, barring 
the use of ResEdit. The shareware extension Easy KEYS 
(Kerry Clendinning, PO Box 26061, Austin, TX 78755) 
comes to the rescue. It lets you assign Fkey documents 
(such as Balloon Printer or Out to Launch) to a key 
combination. The commercial equivalent is Suitcase 
(Fifth Generation Systems 10049 N. Reiger Road, Baton 
Rouge, LA 70809; 800-873-4384), which adds the 
ability to let you easily install sounds and fonts. 

FONTS 
Display Fonts In Menus 
Unless you know your fonts well, you may be left won­
dering what a particular typeface on your menu looks 
like. 1\vo products display menus in a font's native 
typeface. MenuRmts (Dubi-Ciick software, Inc., 
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9316 Deering Ave, Chatsworth, CA 91311; [818] 
700-9525) and WYSIWYG Menus (Now Utilities, Now 
Software, Inc., 520 S.W Harrison, Suite 435, Portland, 
OR 97201; 800-237-2800) let you group families 
and otherwise organize your Font menus across 
multiple applications. 

Keep Fonts In Suitcases 
Installing fonts in System 7 is as easy as dropping them 
into the System Folder. If your system goes south, 
though, so do the fonts. Also, a system with lots of fonts 
can get really slow. That's why the venerable font and DA 
loaders Suitcase (Fifth Generation Systems, 10049 N. 
Reiger Road, Baton Rouge, LA 70809; 800-873-4384) 
and Masterjuggler (ALSoft, P.O. Box 927, Spring, TX 
77383; [713] 353-4090) are still necessary tools for 
anyone who deals with lots of fonts. Both programs also 
include ways to avoid font-ID conflicts when you're 
switching documents among computers. 

GENERAL 
Claris Products 
Here's a time-saving tip for most Claris products: 

Hold down the Command key while launching the 
software, and instead of a new, empty document, you 
will get an Open dialog box that allows you to select 
an existing document. 

HARD DISK 
Change Your Hard-Disk Icon 
Tired of your boxy hard-disk icon? The shareware pro­
gram Visage (Scott Searle, 9025 6Ist Place W, 
Mukilteo, \VA 98275) lets you easily select a new hard­
disk icon from 24 images, including cartoon charac­
ters and groovy-looking hardware. 

Analyze Your Hard Disk 
You can take a look under the hood of your hard 
drive with F\VB's Hard Disk ToolKit (F\VB Inc., 2040 
Polk Street, Suite 215, San Francisco, CA 94109; 
[ 415] 474-8055). This disk-formatting and utility 
package includes an application that automatically 
analyzes your disk (no matter how mysterious the 
drive's origins) and installs an optimized System 7-

164 

savVy driver. The package's diagnostic utilities to 
ensure that you can find out everything there is to 
know about any storage devices you may have con­
nected to your Mac. 

Recovering Hard Disk Space 
A worthwhile option when disk space gets tight is to 
get your hands on a file-compression utility such as 
Stufflt Classic (shareware), Compact Pro (shareware), 
Stufflt Deluxe (from Aladdin Systems), or DiskDoubler 
(from Salient Software). Each of these programs can 
compress a file by as much as 90 percent, depending 
on the type of file. 

The Stufflt products and Compact Pro are totally 
manual- you choose files and then compress them. 
You must also decompress files manually before you 
use them. 

DiskDoubler, on the other hand, is semiautomatic. 
Once a file has been compressed with DiskDoubler, the 
file automatically decompresses and launches the 
appropriate application when you double-click on the 
file and recompresses itself when you close or quit the 
application. 

The latest generation of file-compression utilities­
AutoDoubler (Salient), Stufflt SpaceSaver (Aladdin), 
and More Disk Space (Alysis Software) -works in a way 
that is entirely transparent to the user. Merely install 
them and set a couple of parameters, and your files will 
be compressed and decompressed automatically as you 
use them. Not only that, but the programs can crunch 
files in the background when the computer is idle. 

IN TOUCH 1.1.5 
Removing The Publisher Name From The 
Ftrst Record 
In Touch 1.1.5 is a great program, but it has one annoy­
ing feature- the first record of the file is present 
with the name and address of the publisher, Advanced 
Software, and this information normally can't be 
modified or deleted. The following tip lets you change 
it to whatever you want: 

1. Open a copy of the In Touch DA suitcase with 
ResEdit. 

2. Open STR#-15999. 



3. Scroll down to string 17 and 18; these are the left 
and right sides of the first record, respectively. Change 
them to whatever you like. 

4. Quit ResEdit, saving your changes to the In Touch 
DAsuitcase. Install the modified InThuch DAsuitcase. 

5. InTouch creates the permanent first record when it 
creates a new InTouch file. Create a new InTouch file, 
and you'll have your personalized permanent record 
as the first record. You can then export your existing 
entries (if any) from your old InThuch files and 
import them to new ones. 

I NITS 
INIT Conflict Resolution Made Hasy 
There is a better way to resolve conflicts than by 
removing INI1's (extensions under System 7) one 
at a time. 

1\vo products attempt to make the process of finding 
software conflicts easier. The first is Baseline 
Publishing Inc.'s $69.95 INITinfo Pro, a collection of 
information on system configurations and conflicts 
written by Glenn Brown and Gary Ouellet. It was origi­
nally a shareware product built from reports of soft­
ware conflicts gathered on various online services. 

INITinfo Pro includes a 245-page book and a 
HyperCard stack, which duplicates most of the infor­
mation in the book. The stack allows you to look at 
System 6 information, System 7 information or both. 

While INITinfo Pro's HyperCard stack can produce a 
printed report of all the extensions and applications 
in your Mac system, you have to look up each one 
manually to check for conflicts. Help! from Thknosys 
Inc. ofThmpa, Fla., has taken the next step. Its $149-
product scans your system and attempts to spot poten­
tial software conflicts for you. Help! also will alert you 
to duplicate, out-of-date and damaged applications 
and files. The result of a Help! session is a detailed 
report, which may be read on screen or printed. 

In cases where out-of-date or incompatible software is 
detected, the Help! report provides information on 
contacting the company for an upgrade. 

JUST CLICK 
just Click Under System 7 To Switch 
Between Applications 
If you want to have the old MultiFinder-style applica­
tion switching (clicking in the upper right comer of 
the screen) to System 7, then Just Click ( a freeware 
utility) is a system extension for you. If you're tired of 
pulling down System Ts Application menu and long 
for the good old days, Just Click will bring them back. 
You can find Just Click on ZiffNeVMac and from local 
user groups. 

KEY CAPS 
Access Special Characters 
Can't remember what key combination creates a 
trademark or other obscure symbol? You've probably 
used Apple's Key Caps DA An easier and quicker route, 
however, is to use PopChar, a freeware Key Caps substi­
tute. PopChar displays the character set for the current 
font and then lets you select a character and paste it 
into your document without any complex Shift­
Option keystrokes. 

KEYBOARD 
Delete Flies From The Keyboard 
Basura (Fred's Finder Hacks) lets you highlight a file 
in the Finder and use Command-Delete to put it into 
the Trash. Command-Option-Delete puts the item 
into the can and empties it. 

List Command-Key Shortcuts 
Perhaps your problem is that you have too many 
Command-Key shortcuts and you can't remember 
which does what. When you invoke a hot key, the free­
ware program MenuKey displays a list of all available 
Command-key shortcuts for the application you're 
currently running. 
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KIWIENVELOPES! 3 
Bar Coding With Dot Matrix Printers 
KiwiEnvelopes! 3, an envelope-addressing DA, doesn't 
currently support bar coding on non-laser printers. 
The feature is disabled. 

If you own SuperGlue, though, you can print the bar 
coding on your dot-matrix printer. Open the DA, and 
select Super Glue's SuperlmageSaver II instead of 
your dot-matrix printer. Print your envelope from 
Kiwi Envelopes 3, and save the file in SuperGlue for­
mat. Reselect the printer from the Chooser DA. Open 
the SuperGlue file and print. 

Kiwi Software has stated that tests administered in 
close cooperation with the US. Postal Service indicate 
that dot-matrix printers cannot position a print job 
precisely enough to produce valid bar codes. Kiwi dis­
abled the bar-code feature for dot-matrix printers 
deliberately, and this is documented in their manual. 
A bad bar code may move your mail more slowly 
through the postal system than no bar code at all. 

LAYOUT 
Doesn't Work With System 7 
Mike O'Connor's freeware application, Layout, lets 
people control how Finder 6 handles the desktop, 
including how icons are staggered, how many win­
dows can be open at once, how text is displayed and 
much more. 

In Finder 7, Layout no longer works because the new 
Finder lacks the LAYO resource O'Connor's software 
modified. System 7 offers a Views control panel 
instead, with a few of the same functions, but far less 
flexibility. 

LIFEGUARD 
Eye and Body Saver 
You may have seen many screen savers, but have you 
heard of an eye and body saver? The National 
Academy of Sciences reports that more than half of all 
video-display and microcomputer users polled com-
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plained of eyestrain, headaches, and muscle pain, and 
Business Week reports that RSI (repetitive-strain 
injury) is the fastest-growing occupational disease of 
the 1990s. 

The best way to protect yourself is to take a break every 
so often and do something else. You can do this with a 
software product called LifeGuard. 

LifeGuard is an INIT and DA from Visionary Software 
that interrupts your work at customizable intervals­
with an audible or visual notification - and reminds 
you to do something else. It also keeps track of the 
number of keystrokes you've made in the past hour 
(according to the manual, experts recommend you 
keep your keystrokes to fewer than 12,000 per hour). 
The DA includes illustrated exercises for the eyes, 
neck, shoulders, back, arms, wrists, hands, and legs, 
plus ergonomic reference diagrams to help you create 
a workstation that won't cause you pain. 

MACROS (SYSTEM 7) 
User Scripting 
Apple used to ship a low-end macro program called 
Macro Maker with its OS, but it dropped it with the 
release of System 7. Macros define a set of actions 
(such as opening and printing a file) and activate 
them when you issue one command. Apple had favored 
a higher order of user macros called Apple Scripting; 
however, this too fell out of the final release of System 
7. Several third-party tools let you have low-, medium­
' or high-end macro and scripting capability. 

Macro Maker was picked up by GO Thchnology 
(PO Box 7667, Incline Village, NV 89450; 
800-468-5391), which markets a System 7-
compatible version. Thmpo II (Affinity Microsystem 
Ltd., 1050 Walnut Street, #425, Boulder, CO 80302; 
800-367-6771) is a higherend program that has 
conditional branching for its macros. 

QuicKeys is another scripting and macro creation 
programs. You can perform any task that has a 
macro assigned to it, including complex tasks such 
as program linking and batch processing of files. 
QuicKeys is from CE Software Inc., 1801 Industrial 
Circle, West Des Moines, Iowa, 50265; 
[ 515] 224-1995. 



One program has taken macros to the next -level 
scripting is Frontier (User Land Software, 490 
California Ave, Suite 202, Palo Alto, CA 94306; 
[ 415] 325-5700). Frontier is a high-end develop­
ment environment that provides sophisticated users 
with the tools to really tie applications together. 
With Frontier, you can write a script that searches a 
database for information, extracts that information, 
places it in a page-layout program, formats it, and 
then uploads the layout to a service bureau for 
printing- all without any user interaction. 

MAIL·ORDER 
Buying Software Overnight 
Buying from a mail-order company is the easiest way to 
shop for Mac hardware and software or a Mac itself, for 
that matter. just find the ad in the c ... , .puter magazine, 
get out your credit card, dial the number, and place 
your order. Most mail-order companies promise big 
savings, fast delivery, and, in some cases, money-back 
guarantees. For more on your consumer rights (and 
responsibilities) when buying from a mail-order com­
pany or dealer, see MacUser's "Buying Smart," january 
'91, page 174. 

Here are some tips on how to be a successful mail­
order consumer: 

Know exactly what you want before you call. It's hard 
to browse over the phone, and in many cases, the per­
son on the other end is trained to take your order only, 
not to help you make a decision. If possible, get some 
hands-on experience before you dial go to a dealer to 
comparison-shop, or borrow a friend or colleague's 
copy of the software package you're interested in. Your 
local user group may also be able to give you advice. 
Find out if the product you're interested in is compati­
ble with your system. You should be able to get help 
from an Apple dealer, or you can call Apple customer 
service at 800-776-2333 or (408) 996-1010. 

Use a credit card. Some credit-card companies will do 
such things as double your warranty or give you a 
refund if you find a lower price elsewhere. Even if your 
credit-card company won't go that far, it's worth using 
plastic to pay for your purchases. If the product is never 
delivered or is defective, you can contest the charge with 
your credit-card company and the credit-card company 

will deal with the mail-order company. 

Confirm the price when you place your order. 
Sometimes the printed price isn't current or there are 
hidden charges. If the price is higher than you thought 
it would be, ifs worth trying to see if the company will 
accept the lower price. You should also find out how 
much the delivery charge is. Some companies will 
waive the delivery charge if you order at a certain time 
of day (after 8 p.m., for example). The savings depend 
on what and how much you buy, but you may be able to 
shave at least $5 off the final cost. Ask about delivery 
methods, find out what carriers are used, how fast they 
are, and how much each one costs. 

Make sure the company has a return policy you're com­
fortable with. In most cases, a money-back guarantee 
or a trade-in policy is a must. Find out if you're respon­
sible for paying shipping charges on returned goods 
and whether you'll be charged a "restocking" fee. 

Before you use your new merchandise, make sure it's 
exactly what you ordered the correct model or version 
number, for example. Errors are not uncommon, and 
it's easier to return goods before they've been 
unpacked. 

If you're buying hardware, find out how the company 
handles repairs or replacements. Ask how quickly you 
can expect to get your equipment back if you have to 
send it in for service and whether the company offers 
loaner equipment. 

Thchnical support varies from company to company. 
W'hen buying memory, for example, you may find that 
some companies offer step-by-step installation and 
troubleshooting advice over the phone; others send 
written instructions only. Unless you happen to be a 
techno-expert, it's best to work with a company that 
offers free technical support. 

NODE CHECK 
No Ethernet Checking 
Node Check, Apple's simple address-checking utility 
for LocalTalk that used to be called NetCheck, won't 
give you any useful information about AppleTalk net­
works running on Ethernet. 
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NORTON UTILITIES 
Using The Fast Find DA 
\'V'hen you're using The Norton Utilities for the Mac's 
Fast Find DA, Command-T gives you access to a dialog 
box that allows you to search by type or creator - a 
useful feature for power users that's not mentioned in 
the manual. 

Fast Find Faster 
Although Norton Utilities' Fast Find command is 
extremely speedy, you can make it work even faster if 
you hold down the space bar while it's searching­
this stops the animated sprinting-man icon. 

NOTE PAD 
Better Note Pad DA? 
There's an excellent shareware notepad DA called 
Flash Write II (Andrew Welch, 29 Grey Rocks Road, 
Wilton, CT 06897; $15). It lets you create as many 
pages as you want, and each page can contain as 
many as 32,000 characters. Thxt can be shown in any 
font, size, or style. Flash Write II can import and export 
text files, find text on any page, and count words. 

ON LOCATION 
Calling On Source-Code Collections 
Using On Location is a dandy way to keep track of what's 
on your hard disk, and it's even dandier for program­
mers. For example, if you have megabytes of sample 
source code scattered throughout thousands of files, you 
can use On Location to fully index these files. 

When you need an example of how to use any func­
tion, just call up On Location and search for all the 
references to the function from the source-code collec­
tion. This also lets you view the text in each sample 
source-code file and cut and paste the sample into 
your O\'n program. It's fast and a great way to make 
your programming more efficient. 
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PARTITIONING 
SOFTWARE 
Organizing Your Hard Disk 
Partitioning software divides your disk into multiple 
volumes, each of which is its own "virtual" disk. You 
can use partitions to help organize your files. They're 
a great aid with most backup programs, which work 
volume by volume. If you create a small partition for 
your recent documents, you can back up that volume 
daily and the backups will go quickly. Keep older doc­
uments in a separate partition. For security, partitions 
can be password-protected, and if you share your hard 
disk, partitions can give all users their own private 
work areas. 

You can keep older versions of software in a separate 
partition for when it's necessary to use an old version 
of a program. You don't want both the old and new 
version on the same volume, because when you dou­
ble-click on a document, you don't know which ver­
sion of the application will open. 

The Finder also slows down when a disk has too many 
files and the System Desktop file gets too big- so 
partitioning your disk limits each volume to a size the 
Finder can manage. 

POSTSCRIPT PRINTER 
Finding PostScript Problems 
Many Mac users have yet to come to grips with the fact 
that their PostScript printers, far from being simple 
output devices, are separate computers of labyrinthine 
complexity. and that the printers' internal page 
description language is understood completely by only 
three people, all of whom work at Adobe Systems Inc. 

A company called Chesire Group has quietly been sell­
ing a killer utility called PinPoint Error Reporter. 
This little $89.50 gem is a program that loads into 
your PostScript printer, intercepts error conditions and 
produces a very detailed error report. PostScript hack­
ers will love it, but even those of us who don't know 
PostScript will find it useful since it isolates the loca­
tion on the page where the error occurred, letting you 



change your work to eliminate the error. 

Cheshire Group is at 321 S. Main St., Suite 36, 
Sebastopol, CA. 95472. Phone (707) 887-7510; fax 
(707) 887-2595. 

POWERBOOK 
CursorFtxer 
Dennis Brothers has written a handy extension that 
solves a problem for PowerBook users: the disappear­
ing I-beam cursor. His Cursor Fixer extension replaces 
the near-invisible-on-LeD-screens I-beam with a fat­
ter one that is easier to see. It also swaps a thicker 
cross-hair cursor for the one-pixel-wide one used in 
many graphics programs. Brothers has uploaded the 
free program to several on-line services. 

PowerSieep 
Although you can put the PowerBook to sleep from 
either the Battery DA or the Special menu, a better 
method is to use the freeware Fkey program 
PowerSleep (available from ZiffNeVMac and other on­
line services). PowerSleep lets you use a keyboard 
command equivalent to put the system to sleep, and 
unlike other methods of invoking Sleep, it won't wake 
up a sleeping hard disk, which can be a significant 
power drain. 

PRINTER (SYSTEM 7) 
View Printer Queues 
System 7 prints more slowly than does System 6. 
Maybe that's why Blue Parrot (CasaBlanca Works, 
Inc., 148 Bon Air Center, Greenbrae, CA 94904; 
[ 415] 461-2227) is such an attractive application. It 
lets you view who's printing what and in what order on 
a shared printer. With multiple printers on a network, 
you can choose the one that's less busy. 

QUICKEN 
Customizable Command Keys 
Hold down the Command key when you choose a 
menu item that lacks a keyboard command equiva-

lent. This action brings up a dialog box that lets you 
assign Command-key shortcuts. You can also use this 
technique to delete or change existing keyboard 
shortcuts. 

Keyboard Navigation In Lists 
When the Account, Category, Class, Memorized 
Transaction, or Transaction Group list is the active 
window, simply type the first letter or first few letters to 
select the desired item in that list. 

Adjust Date/Check Number. You can use the + key or 
the - key to increase or decrease the date and/or check 
number by 1. 

QUICKEYS 2 
Updating Application-Specific Macros 
QuicKeys 2lets you create program-specific macros 
that are stored according to the name of the individu­
al application. After you upgrade a program to a 
newer version, you may discover that all your 
QuicKeys macros for that program have disappeared. 
You can retrieve them by opening the QuicKeys 
resource and changing the program names and/or 
version numbers to the new ones. Here's how: 

Open the Preferences folder in your System Folder. 
Inside the QuicKeys folder is a QuicKeys Preferences 
folder, which contains a KeySets folder where all your 
macro sets are arranged by program name. Simply 
change the version number on the filename, and 
you're set. 

Using QuicKeys 1b Print 
If you program QuicKeys to scan the menus looking for 
"Print..." and find that it doesn't work in some applica­
tions, remember that some applications do the ellipsis 
after Print with three periods and some do it with 
Option-semicolon. They may appear the same on the 
screen, but to QuicKeys they're quite different. Solution: 
Define an application-specific QuicKeys file for each of 
these applications. 

Recovering After A Program Upgrade 
QuicKeys 2lets you create program-specific macros 
that are stored according to the name of the individ­
ual application. After you upgrade a program to a 
newer version, you may discover that all your 
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QuicKeys macros for that program have disappeared. 
You can retrieve them by opening the QuicKeys 
resource and changing the program names and/or 
version number to the new ones. Here's how: 

Open the Preferences folder in your System fulder. Inside 
the QuicKeys folder is a QuicKeys Preferences folder, 
which contains a KeySets folder where all your macro 
sets are arranged by program name. Simply change the 
version number on the filename, and you're set. 

QUICKEYS 2.1 
Timing QuicKeys To Empty The 'Jioash 
Since the Trash under System 7 doesn't automatical­
ly empty at shutdown or restart as it did under 
System 6, several freeware and shareware utilities 
have arrived to automate the process. QuicKeys 2 
can do this just as easily, however. Just create a 
Menu/DA macro that selects Empty Trash from the 
Special menu in the Finder, and click on the Timer 
Options button to set macro to be activated 0 seconds 
after your Macintosh starts. 

If you have any applications in your Startup Items· 
folder, you'll instead want to make a sequence in 
QuicKeys 2: First, set up a Menu/DA macro (look on 
the Define menu in the Sequences dialog box) that 
chooses the Finder from the Application menu in the 
upper right corner of the screen. Second, use the 
Menu/DA selection, on the Define menu, to choose 
Empty Trash from the Special menu. QuicKeys waits 
until everything in the Startup Items folder has been 
launched before it starts to execute any macros. [This 
QuicKeys macro is available in Library 5 (Scripts & 
Thmplates) of the ZiffNet/.Mac Download & Support 
Forum; the filename is QTRASH.CPT.] 

QUICKliME 
Add a Video Beep 
Video Beep, QuickTime freeware, replaces the standard 
system beep with a video of your choice. 
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READ MACWRITE 
Reading Mac Write Files Without The 
Application 
Many software developers continue to use MacWrite for­
mat as their standard for on-disk program documenta­
tion. This can be inconvenient if you don't have 
MacWrite. You have to open up Microsoft Word or some 
other word processor and import the file, even if all you 
want to do is take a peek at the documentation. 

You can modify Word's Creator to MSWD using 
ResEdit. However, if you're not comfortable with 
ResEdit or if text files are what you're after, there's a 
nice shareware utility, Read MacWrite, that opens 
MacWrite files and scrolls through them on the screen 
while saving the contents as a plain text file. Now if 
you need to take a look at some documentation on 
the fly, you can just open the file with a DA such as 
miniWRITER (which is also shareware). 

You can pause the scrolling, but Read MacWrite lacks a 
text buffer and elevator boxes for scrolling back over 
what you've read. Once the text has scrolled by, it's gone 
until you reopen the file and start at the beginning. 

Read MacWrite's quick production of text files from 
MacWrite-formatted documents would also come in 
handy if you had several Mac Write files that you need­
ed to get into plain-text format in a hurry. 

Read Mac Write is available in the Download Library 
Forum on ZiftNet/Mac. 

RES EDIT 
What Is ResEdit? 
ResEdit is Apple's resource-editing software. All Mac 
software contains resources, which create things such 
as menus, cursors, icons, dialog boxes, and so on. 
When you're adept with ResEdit, you can edit menu 
items, colors, desktop patterns, and keyboard com­
mand equivalents; alter wording in dialog boxes; cre­
ate and modify icons; and so on. 

You can get ResEdit directly from APDA (the Apple 
Programmers and Developers Association) for $49.95. 
Contact APDA at 800-282-2732 or 



( 408) 562-3910. And if you have a modem, you can 
download the latest version from CompuServe, 
America Online, or GEnie. Try your user group, too. 

If you don't have a modem or a user group, SMUG 
(Berkeley Macintosh User's Group) offers a $15 
package that includes ResEdit and SMUG's excellent 
book Zen and the Art of Resource Editing as well as 
several utilities and a beautiful collection of icons 
and jumbo desktop patterns. Contact SMUG at 
1442A Walnut Street, Suite 62, Berkeley, CA 94704; 
(510) 549-2684. 

A more sophisticated and full-featured resource 
editor is Resorcerer, available from 
Mathemaesthetics Inc. at P.O. Box 67156, Chestnut 
Hill, MA, 02167; (617) 738-8803. Developers will 
appreciate features such as scripting repetitive 
tasks, System 7 feature support, templates, editing 
of Apple-Events scripting resources and much 
more. 

NDS Across Your Startup Screen 
If you dislike those INIT startup icons goosestepping 
across your startup screen and the programmers didn't 
see fit to give you the option of disabling the icons, 
there is a simple solution: You can change the icon ID 
number, using an icon editor such as Icon Designer or 
a resource editor such as ResEdit, thereby eliminating 
the startup icon without affecting the IN IT itself. 

Use a consistent pattern when you change the num­
bers so that you can restore them later if you need to. 
For example, change ID number 128 to 12800 or 
change ID number -4023 to +4023. 

The patterns you use don't matter- just be consistent. 
After you've changed the ID numbers, your startup 
screen will be untrodden. 

Changing The Shutdown Screen 
If you want to change the Shut Down screen that says 
"You may now switch off your Macintosh safely," use a 
copy of ResEdit and follow the steps below: 

1. Make a copy of the System file, using the File 
menu's Duplicate command. 

2. Launch ResEdit, open the duplicate copy of the 
System file, and locate the DSAT resource. 

3. Double-click on this resource, and then double­
click on the ID 2 file. 

4. Scroll down until you see the "You may now ... " 
message in the narrow right column. 

5. Starting with the letter Y, highlight the message 
through the last character, a period. 

6. Carefully type in your message, using exactly 45 
characters, including spaces. Save your changes. 

7. Quit ResEdit, shut the Mac down, and restart from a 
floppy disk. 

8. Save a copy of your original System file on a floppy 
disk. Replace the hard disk's System file with the dupli­
cate copy, and change the copy's name to System. 

9. Restart your Mac from the hard drive, and choose 
Shut Down from the Special menu. 

10. Your message should appear the way you typed it. 
If you did something wrong, the Shut Down screen 
will flash, but that shouldn't cause any major prob­
lems. Simply trace these steps, and make sure that you 
typed exactly 45 characters. 

Deleting Sound Resources 1b Save Space 
Digitized-sound resources are fun but are also often 
very large and expendable. If you're running short of 
disk space or if you're looking for ways to reduce 
telecommunications time, you might want to use 
ResEdit to locate the snd resources on a copy of the 
application or stack. Delete the resource, save the 
program, and make sure the program still works. 
The About box or startup screen might be less enter­
taining, but the program will be a lot leaner. 

Reassigning The Shift-Period Key Combo 
If you've ever tried to type P.O. Box quickly on a typical 
Mac keyboard, you've probably wished that the Mac key­
board functioned more like a traditional typewriter, with 
Shift-period producing a period (instead of>) and 
Shift-comma producing a comma (instead of<). Here's 
a way to reassign these keys, using ResEdit 21 or later: 

1. Make a copy of the System file in the System Folder 
by, using the Duplicate command (Command-D) on 
the File menu. Remove the copy to a nonboot disk or 
partition (having two System files on your boot disk 
can cause problems). 

2. Open the copy with Res Edit, and open the KCHR 
resource, which controls the mapping of ASCII char­
acters to keyboard keys. 
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3. The keyboard display in the bottom third of the 
window changes as you press the modifier keys, in the 
same way as it does with the Key Caps DA. Hold down 
the Shift key to display the shifted keyboard map. 

4. Using the mouse, drag the desired character (in 
this case, the period) from the palette in the top two­
thirds of the window onto the key you want to repre­
sent it. Do the same with the comma. (Because this 
operation replaces the > and < symbols with the peri­
od and comma, you might want to assign the < and 
> symbols to the Option-Shift positions on their 
respective keys so they're still accessible.) 

5. Close the KCHR resource, and save the changes to 
the System file. Restart the Mac from a floppy disk, 
store the old System file in some place other than the 
boot disk, and place the edited version of the System 
file in the System Folder. Restart the Mac. This will 
eject the floppy disk, and your Mac will reboot with 
the new System file in place. 

This change affects the keyboard mapping, not the 
font information, so it should be font-independent. 

Customizing The Shutdown Message 
If you want to change the message in the Shut Down 
screen (the one that says, "You may now switch off 
your Macintosh safely.") - Here's how to do it, using 
ResEdit on a copy of your System file: 

1. Make a copy of the System file, using the File 
menu's Duplicate command. 

2. Launch ResEdit, open the duplicate copy of the 
System file, and locate the DSAT resource. 

3. Double-click on this resource, and then double-click 
on the ID 2 file. 4. Scroll down until you see the "You 
may now ... " message in the narrow right column. 

5. Starting with the letter Y, highlight the message 
through the last character, a period. 

6. Carefully type in your message, using exactly 45 
characters, including spaces. Save your changes. 

7. Quit ResEdit, shut the Mac down, and restart from a 
floppy disk. 

8. Save a copy of your original System file on a floppy 
disk. Replace the hard disk's System file with the 
duplicate copy, and change the copy's name to System. 
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9. Restart your Mac from the hard drive, and choose 
Shut Down from the Special menu. 

10. Your message should appear the way you typed it. 
If you did something wrong, the Shut Down screen 
will flash, but that shouldn't cause any major prob­
lems. Simply re-trace these steps, and make sure that 
you typed exactly 45 characters. 

Increasing The Desktop Pattern Pixel Grid 
Under normal circumstances, the desktop pattern 
contains a series of 8 x 8-pixel grids, which you can 
edit in the General Controls control panel (usually 
located on the Apple menu). You can use Res Edit to 
increase each grid's size to as much as 64 x 64 pix­
els, which allows you to create much more detailed 
desktop patterns (for example, you might re-create 
your company's logo as your desktop pattern). You 
can also paste in a picture (as large as 64 x 64 pix­
els) from the Clipboard and use that as your desktop 
pattern. Here's how: 

1. Launch ResEdit, and open a copy of the System file. 

2 Double-click on the ppat resource, and then double­
click on the resource with the ID number 16. This 
opens the pattern editor 

3. Choose Pattern Size from the ppat menu. Choose a 
new pattern size in the dialog box, and then click on 
the Resize button. 

4. Create a new pattern in the pattern editor, or paste in 
a picture from the Clipboard (If you paste in a picture 
that's bigger than the size you set, you'll see only one 
comer of it. To get around this, choose Command-A 
[Select All] from the Edit menu- ResEdit will resize 
the pasted picture to fit the area you've selected.) To see 
how your new desktop looks, choose Try Pattern from 
the ppat menu. 

5. When you're satisfied, choose Save from the File menu 
and quit ResEdit. Move the edited copy of the System file 
into your System R>lder (you may have to boot from a 
floppy to do this), and restart your Mac. 

Opening A Generic Document With A 
Specific Application 
When you double-click on a generic text or PICT docu­
ment in the Finder, you get a message that tells you 
that the document couldn't be opened because its 
application couldn't be found and then asks if you want 



to open the document in Teach Text. Most of the time, 
youtl rather open it with your word processing, paint­
ing, or retouching program, wouldn't you? If so, all you 
have to do is change the associated creator code in the 
Finder's fmap resource. Here's how to do it: 

1. Launch ResEdit, and open a copy of the Finder file. 

2. Double-click on the fmap resource, and then dou­
ble-click on resource ID 17010. 

3. Notice that the first line displayed on the far right 
side is TEXTttxt. Since ttxt is the creator code for 
Thach '!ext, all you have to do is drag-select those four 
characters and replace them by typing in the four­
character creator code of your favorite word-process­
ing program. For example, Word is MSWD, Nisus is 
NISI, and Mac\Vrite II is MWII. (To find an applica­
tion's creator code, use ResEdit to open a document 
created by that application and choose Get Info.) 

4. While you're messing around, change the ttxt after 
PICT in the second line to match the code of your 
favorite graphics application that can read PICT files. 
For example, MacDraw Pro is dPro, Canvas 3.0 is 
DAD2, and Photoshop is 8BIM. 

Note: Type the creator codes exactly as shown -using 
uppercase or lowercase letters actually matters here. 

5. Save the file, and quit ResEdit. Move the edited 
copy of the Finder file into your System Folder (you 
may have to boot from a floppy to do this), and restart. 

The Finder even knows to substitute the name of your 
application for Thach Thxt in the dialog box. Now it'll 
read, "The document X couldn't be opened, because 
the application program that created it couldn't be 
found. Do you want to open it using Microsoft Word?" 
(or whatever program you've chosen). 

Adding A Command-Key For Save As 
Command-key shortcut for Save As to a copy of Thach 
Thxt (you can extend this technique to many other 
applications). 

1. Launch ResEdit, and open a copy of Thach Text. 

2. Double-click on the MENU resource, and double­
click on the picture of the File menu (it should have a 
small figure 2 beneath it). This opens the menu editor. 

3. Click on Save As in the picture of the menu at the 
right of the menu editor, and then click in the text-

entry box next to Cmd-Key and type the Command­
key shortcut you want to assign to Save As. Be careful 
not to choose a key that is in use elsewhere in the pro­
gram. After examining all the menus and determin­
ing that it wasn't used elsewhere, I chose the letter E. 

4. When you're satisfied, quit from Res Edit, saving the 
file when prompted. 

That's all there is to it. The next time you use Thach 
Thxt, Command-E (or whatever you've chosen) will 
invoke the Save As command. By the way, you may 
have noticed that this resource lets you add color to the 
text and Command-key shortcuts as well as add icons. 

Editing The Finder's Menus 
Here's how to edit the Finder's File menus: 

1. Launch ResEdit, and open a copy of the Finder file. 

2. Double-click on the fmnu resource, and then dou­
ble-click on ID 1252. This brings up a window filled 
with arcane text and numbers. 

3. In the far right column of text, you'll notice some 
familiar strings from the Finder's File menu, such as 
New Folder, Close Window, and other commands. The 
Command-key shortcuts for these (and all other 
Finder menu items) are stored in the third character 
before the name of each item - the N before New 
Folder and theW before Close Window, for example, are 
what determine the Command-key shortcuts for these 
options. A menu item with no Command-key shortcut 
just has an empty box in the appropriate place. 

4. To change or add a Command-key shortcut, select 
the appropriate character in the right-hand column 
and type in capital letters the key you want. It's 
important that you select only the character you want 
to replace. If you put the cursor to the right of the 
character, delete it, and then replace it, the Finder 
may reorder your menus or behave in other unpre­
dictable ways. 

5. Save the changes, quit Res Edit, move the edited copy 
of the Finder file into your System Folder (you may 
have to boot from a floppy to do this), and restart your 
Mac. The new Command-key shortcuts should show 
up in the menus once the new Finder has loaded. 

This technique works on the other Finder menus as 
well. The Edit menu is ID 1253, and the Special menu 
is ID 1255. 
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RESEDIT 2 
Turning An EPS Image Into A Startup 
Screen 
If you want to turn your favorite EPS image into a 
startup screen, for example, or want to otherwise pro­
cess it on a pixel level, try ResEdit. 

Open the EPS file with Res Edit and you'll find a 
resource of type PI CT. Open it and click on the image 
and copy it to the clipboard (with Command-C). Open 
MacPaint (or any graphics program that can save files 
as startup screens), and paste (Command-V) the 
image into the MacPaint window. You can do this even 
if the original PICT image was in color- although it 
will be converted to black-and-white. 

RESEDIT (SYSTEM 7) 
Freeing The Finder 
Although it's true that System 7 can run on a 2-
megabyte Mac, you won't have room in memory to 
run much else. Here's how to make the Finder quit 
when you're running an application, thus freeing up 
(approximately) 300K of RAM: 

1. Make a copy of the Fin de[ (Never use Res Edit on an 
original file.) 

2. Launch ResEdit, and open the copy of the Finder file. 

3. Double-click on the fmny resource. 

4. Double-click on ID 1252. This will bring up a win­
dow filled with arcane text and numbers. 

5. Scroll to the bottom of the window. Click once to 
place your cursor just to the right of the characters 
016D. 

6. Type 7175697481000000045175697400 (ResEdit 
automatically inserts the spaces for you). 

7. Scroll back to the top of the window. In the upper 
left corner, you' II see 000000 and, just to the right of 
that, 0001 0011. Change 0011 to 0012. 

8. Save the changes, and quit ResEdit. Move the edit­
ed copy of the Finder file into your System Folder (you 
may have to boot from a floppy to do this), and then 
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restart your Mac. The Finder now sports a Quit com­
mand. 

Note: There are a couple of drawbacks to adding this 
command- mainly that you'll lose your Apple 
menu. You'll still have the Apple and probably the 
About menu item, but you won't be able to see any of 
the other goodies on that menu. The other major 
annoyance is that the only way to get the Finder run­
ning again is to quit all open applications. If you try 
to quit when no other application is open, the Finder 
will simply restart itself. 

SAVE 
Auto-Save Documents 
Unless you save documents meticulously every few 
minutes, it's likely that you've had a system crash 
destroy some of your work. Programs such as 
AutoSave II do a save for you at regular intervals. The 
same type of utility is being bundled with other pack­
ages -WorkSaver ( QuickThols, Advanced Software, 
1092 E. Duane Ave, Suite 103, Sunnyvale, CA 94086; 
800-346-5392), and NowSave (Now Utilities, Now 
Software, Inc., 520 S.W. Harrison, Suite 435, Portland, 
OR 97201; 800-237-2800), to name two. 

SECURITY 
Password-Protect Folders and Disks 
If you lock your file cabinet at work or home, then 
you'll want to do likewise with your Mac. It's easy to 
go overboard with complicated security packages, but 
a little basic protection may be good enough to serve 
as a deterrent for prying eyes. FolderBolt (Kent Marsh 
Ltd., 1200 Post Oak Blvd., Suite 210, P.O. Box 460289, 
Houston, TX 77056; 800-325-3587) simply locks 
designated folders through use of a password. 
DiskLock (Fifth Generation Systems, 10049 N. Reiger 
Road, Baton Rouge, LA 70809; 800-873-4384) 
and Barricade ( QuickTools, Advanced Software, 1092 
E. Duane Ave, Suite 103, Sunnyvale, Ca 94086; 
800-346-5392), on the other hand, require use of a 
password for you to mount a hard disk. 



SCREEN 
Enlarge Your Screen Area 
MaxAppleZoom (Naoto Horii, BP 1415, B-1000, Brussels, 
Belgium) eliminates the black border you usually see 
on an Apple 13-inch monitor so that you can use it as 
screen space. The utility uses some previously unused 
RAM on the video card to create an image with more 
pixels. fts a result, you can increase the display area of 
your Apple 13-inch monitor by about 20 percent­
from 640 x 480 to 704 x 512 pixels. 

Switch Among Screen Depths 
Some applications work better in black-and-white, 
and others demand color. If you want to avoid going 
to a control panel to switch among pixel-depth 
modes, then get Pixel Flipper or Screen Flipper, share­
ware extensions that provide a Command-key short­
cut to invoke a change. The commercial alternative, 
HAND-Off II (Connectix Corp., 2655 Campus Drive, 
San Mateo, CA 94403; 800-950-5880), is smarter. It 
lets you define the correct mode for each application 
and then switches to it automatically as you switch 
applications. 

Switch-A-Roo is a freeware utility that will do the 
same thing. See Switch-A-Roo later in this section. 

SCROLL BARS 
Add Bidirectional Scroll Bars 
The problem with Mac's scroll-bar arrows is that you 
have to travel to either end of the screen to go in a par­
ticular direction. Scroll2 (Mayson G. Lancaster, 1492 W 
Colorado Blvd., Pasadena, CA 91105) puts bidirectional 
arrows at both ends of the scroll bar so that you can go 
down even if your cursor is at the top of the screen. 

Another utility that will do this is AltCDEE AltCDEF, by 
Alexander Colwell, puts bidirectional arrows at each 
end of the scroll bars. Compared to other renditions 
of scroll bar enhancers, AltCDEF has the cleanest and 
most unobtrusive interlace, and it comes with special 
shift and option commands for added scrolling bene­
fits. AltCDEF is freeware, System 7 compatible and is 
available from on-line services and user groups. 

SEARCH UTILITIES 
Search All'ICxt on a Disk 
If you can't jog your memory for the filename you're 
after, you may need more powerful search software -
a text-retrieval program. Gofer (Microlytics, Inc., 1\vo 
Tobey Village Office Park, Pittsford, NY 14534; 
800-828-6293) and On Location (ON Thchnology, 
Inc., One Cambridge Center, Cambridge, MA 02142; 
[ 617] 225-2545) are two heavyweight applications 
that can scan the contents of files for a string, word, or 
phrase. 

On Location pre-indexes your entire hard disk (or 
other mass-storage device) to make text retrieval 
nearly instantaneous. For the "lite" version of text 
retrieval, look at Super Boomerang (Now Utilities, 
Now Software, Inc., 520 S.W Harrison, Suite 435, 
Portland, OR 97201; 800-237-2800). You use its Find 
command to search through files for a string. Super 
Boomerang doesn't have the feature set of the other 
programs, but it still gets the job done. 

SET CLOCK 
Recalibrating The Mac Clock 
If your Mac gains several minutes a month, you can 
recalibrate the internal clock with a program called 
Set Clock. It makes a 10-second call to an atomic 
clock in Toronto or Chesapeake, Va., and resets your 
Mac clock to match. It's available as SETCLK.SIT in 
the Utilities library of MacSys on CompuServe (GO 
CIS:MACSYS), as well as other on-line services and 
user groups. 

SHADOWWRITER 
Networking The Laserwriter LS, SC And 
Style Writer 
Gizmo Technologies of Fremont, California, sells soft­
ware called ShadowWriter that lets you network Apple's 
LaserWriter LS, SC and Style Writer 

The Mac to which the printer is connected sponsors 
the printer on the network, so other Macs can select 
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the device in the Chooser and print to it. Each Mac on 
the network must have the printer driver for the type of 
printer in use, and of course you need to make sure 
that the various fonts and font renderers, such as 
TrueType and Adobe Systems Inc.'s Adobe Type 
Manager, are consistent. 

SOFTPC 
Speeding Up The Display Screen 
There are a few things you can do to speed up SoftPC 
graphics besides upgrading to a faster Mac or an 
accelerated display card. Running in black-and-white 
mode will make text display a lot faster Another trick 
is to use a fast console driver replacement such as 
QCRT, which reportedly almost doubles SoftPC's text­
scrolling speed. The driver is available as QCRT2l.ZIP 
in the IBM Hardware forum on CompuServe (type GO 
CIS:IBMHW). 

SOUND CONVERTER 
Editing Sounds 
When you want to tum sounds into sound resource files, 
the sounds are often at the wrong sampling rate. A utility 
called Sound Converter converts SoundF..dit, SoundWave, 
or SoundCap files into sound resources and lets you 
choose the sampling rate when you convert sounds 
(although it doesn't let you change the sampling rate of 
an existing sound resource). 

Sound Manager is a sound-manipulating shareware 
utility that can do any type of conversion, play sounds, 
and let you do some light editing. But you'll also need 
SoundF.dit (one of the applications that is included 
with Farallon's MacRecorder sound digitizer) if you 
want to change the sampling rate of the resource. 
Sound Manager can convert sounds to SoundF.dit for­
mat; SoundEdit can save the sounds with a different 
sampling rate (although it can convert only from 
faster rates to slower rates). 
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SOUNDMASTER 
Add Sounds To Mac Actions 
Bruce Tomlin's SoundMaster, a popular shareware 
control panel, lets you add sound to most Mac actions. 
Install it, and you'll be able to specify a sound that 
will play when you start up; restart; shut down; insert 
a disk; eject a disk; press the Tab, Shift, Return, or 
Delete key; and more. 

Yes, SoundMaster is silly, but it sure makes using a 
Mac a lot more fun. If you want to use it with System 
7, however, make sure you get Version 1.7.3, now widely 
available from on-line services and user groups; you 
can download SoundMaster sounds plus some cool 
sounds and other sound-manipulating software by 
downloading a package of goodies on MacUser's 
on-line service, ZiffNeVMac. You'll find it in the 
Download & Support Forum (filename BTSSNS.CPT). 

STEPPING OUT II 
Disabling Stepping Out II Upon Launching 
An Application 
Stepping Out II is a useful addition to the Mac, giving 
the effect of a larger screen. Many people keep it on all 
the time. But some programs, particularly games and 
telecommunications software, are better off Without it. 
To save yourself a trip to the Control Panel, launch 
your program while holding down the Option key, and 
Stepping Out II will automatically shut off. You 
should use the Control Panel to turn it back on when 
you Quit, though. This is an undocumented and 
handy reversal of Stepping Out's QuickStart feature. 

Stepping Out As A Screen Shrinker 
Stepping Out II is a screen extender that allows the 
creation of large virtual screens on the Mac. Although 
most people can readily see the benefit of this (partic­
ularly for the 9-inch screen of the Plus and SE), there 
is another benefit for those who would rather use a 
larger monitor while developing applications for the 
smaller, standard screens. 

Stepping Out II also functions quite effectively as a 
screen shrinker. Creating a small screen size is simple. 
First, call up Stepping Out II from your Control Panel. 



Click New and enter the pixel count for the screen size 
you want (512 pixels wide by 342 high for the Mac SE). 
Then, enter a name for your screen definition (such as 
"Mac SE Screen") and click Save. Finally, highlight the 
name of your new screen setup and click Set. If you 
have enough memory reserved for the new screen (and 
assuming that Stepping Out II is active), the change 
takes place immediately. Otherwise, you will first need 
to reboot. 

Once all this is accomplished, you can easily switch 
from one screen size to the other by simply turning 
Stepping Out II on or off from the Control Panel. 

STUFF IT 
Automatically Unstuffing All Archived Ales 
Stufflt has a hidden (and very handy) feature. After 
selecting the archive you wish to open (or after click­
ing in the About box if you opened an archive and not 
the program itselO, hold down the Shift key and 
Stufflt will automatically select all the files, decom­
press them, and save them to disk. 

Halting Stuffit Operations 
Simply pressing Command-period - the usual 
method for halting operations on the Macintosh­
doesn't stop the stuffinglunstuffing operation in 
Stufflt. Instead, you need to hold down Command­
period continuously until the operation has stopped. 

Archiving Several Files 
If you need to send more than 20 files via modem, you 
will need to send data in at least two sessions. Save your­
self some time by enclosing all the files in one folder. 
Stufflt can archive entire folders of various sizes. 

SUITCASE II 
Distinguishing Between Bitmapped And 
Postscript Fonts 
If you can no longer remember which of your fonts are 
bitmapped and which are PostScript, you can use 
Suitcase II to find out. 

Select Suitcase II from the Apple menu, and click on 
the Fonts radio button or type Command-F. Select any 

font name and click on Show, or double-click on a 
fontname. 

Above the sample text, Suitcase will list the printer 
font filename if the font is PostScript. If the font cho­
sen is a bitmapped font, the message "This is a 
bitmapped font" will appear. 

SWITCH·A·ROO 
Switching Among More Than Two Screen 
Depths 
Switch-a-Roo is one of the most useful FKeys avail­
able for the Mac II. If you need to switch between 
more than two screen depths, however (because you 
have a 24-bit monitor, for instance), the FKey will 
come up short. If you need to switch among 2, 16,256, 
and 16 million colors often, you can modify Switch­
a-Roo to allow two copies of the program to run at 
the same time. Here's how: 

1. Make a copy of Switch-a-Roo. 

2. Using Res Edit, select the copy of the FKey. First, use 
the Get Info command to change the ID to a number 
other than 9 that your system isn't using currently. 

3. Next, open the file and scroll down to byte 2417. In 
the ASCII translation of the hex code, you will see Roo 
File. Change this filename to something that uses the 
same number of letters (for example, Row File). 

4. Save the file, and install it into your system, using 
ResEdit, or load it with Suitcase II. 

This modification will make the two copies of a 
Switch-a-Roo run concurrently, with each assigned to 
a different keystroke. You may want to make one copy 
switch between 2 and 256 colors and have the other 
switch between 16 and 16 millions colors. Even if you 
have to switch among only three screen depths, it's 
still easier to have two copies running concurrently 
than to go to the Monitors cdev or to call up the full 
screen to reconfigure Switch-a-Roo. In addition, you 
can assign these FKeys to the functions keys on the 
extended keyboard, so any screen depth is no more 
than one or two keystrokes away. 
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SYSTEM 
Analyze Your System Configuration 
If, for example, you have extension-management problems 
and you need to get advire from an expert, it helps to know 
exactly what sort of system you're using. Several report gen­
erators can tell you intimate details about your Mac. 
Profiler (Now Utilities, Now Software, Inc., ~S.WHarrison, 
Suite 43~ R>rtland, OR 97201; 800-237 -2800) and 
Thchnical Assistanre Assistant (distributed with most CE 
Software packages) give an exhaustic report on your system 
configuration, down to the number of bytes each extension 
takes up in the system heap. 1attleThle is a freeware DA that 
does all of the above and has an exrellent help system, ton 

SYSTEM ERROR 
TABLE DA 
Printing The Error 'lllble 
Pyro! co-author Bill Steinberg produces a concise list 
of system error and bomb-code definitions on the 
Macintosh in the form of aDA, called System Errors DA 

You can't order it directly, but you can download it 
from ZiffNeVMac or from CompuServe's MAUG forum .. 

You can view any error opening the DA, but you have to 
have a working Mac before you can use it! A good idea 
is to keep a printed list of codes tacked up by your desk. 

Here's how to do just that, if you have a copy of 
ResEdit. First, make a copy of the system Errors DA. 
(Always work on a copy when you're using Res Edit 

Launch ResEdit, and double-click on the System Errors 
DA. In the window that opens, double-click on the 
TEXT item. Now double-click on TEXT "SysErrorList 
2.1c ID=-15392 (it may have a slightly different name if 
you have a different version of the DA). 

Next, select all the text by either dragging from the 
beginning to the end or clicking just before the first 
character, scrolling to the end of the text, holding down 
the Shift key, and clicking after the very last character. 
Select Copy from the Edit menu. Now quit ResEdit, 
launch your favorite word processor, and paste. You 
now have a text version of the error codes. 
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SYSTEM PICKER 
You Can Keep System 6 And 7 On Your Hard 
Disk 
Yes, you can, although it's a little clumsy. If you have 
a disk that can be partitioned, one solution is to 
define separate partitions for the two systems and 
switch partitions to switch systems. 

If your disk can't be partitioned or you don't want to 
reformat it, the solution is a little more complex. You 
need to keep a separate System folder for each system 
and select which one you want to use with a little util­
ity called System Picker (previously known as 
Blesser), available from ZiffNeVMac, CompuServe and 
local user groups. 

First, install System 7. (To do this without erasing 
System 6, select your current System folder and choose 
Duplicate from the File menu before installing). You 
now can use System Picker to select which System 
folder will be used the next time you boot up. Note 
that you should always reboot the Mac immediately 
after using System Picker. Otherwise, your Mac can 
get confused. 

When you're running under System 6, you'll see extra 
folders on your disk called Desktop and Trash. Don't 
erase these; they're created and maintained by System 
7. When you switch back to System 7, you'll likely see it 
update the disk. This step is necessary to accommo .. 
date whatever changes you've made to the disk and file 
structure under System 6. 

TATTLETALE 
Great System Reporting Utility 
TattleTale is a desk accessory, from john Mancino, for 
examining Macintosh configuration details, and it's 
free. Mancino asks only that you do something posi­
tive for the environment in return for using the soft­
ware (it's also Ecoware). 

TattleTale details all aspects of a Macintosh configura­
tion, including NuBus cards, SCSI chain, memory; pro­
cessors, ROM and operating system versions, Desktop 
Bus devices, fonts, system extensions, open files, and 
active processes. 



TattleTale is also System 7 compatible, and also pro­
vides a special feature list for programmers that lists 
the "traps" that are available and those that are miss­
ing from the system. 

TUSH (SYSTEM 7) 
Empty 'Ihlsh on Shutdown 
Under System 6, trash gets thrown away when you shut 
down But under System 7, it keeps piling up until you 
select Empty Trash from the Special menu. Trash Chute is 
a freeware extension that empties the trash when you 
shut down. It also uses Apple events to delete files when 
you drag them over the application icon. 

USER GROUPS 
Obtaining Utilities Without A Modem 
If you want to obtain many of the utilities mentioned 
here or elsewhere but don't have a modem to down­
load the stuff from on-line services, there are 
Macintosh user groups. 

If you don't have a local user group, you can try the 
BMUG (Berl<eley Macintosh User Group) software library, 
one of the most complete in the country. It offers a cata­
log of programs and sells disks of programs. You might 
consider joining BMUG just to get its newsletter- a 
semiannual300-to-400-page extravaganza. 

BMUG can be reached at 1442A Walnut Street, #62, 
Berkeley, CA 94709-1496; 800-776-BMUG or 
(510) 549-2684. 

Another user group is the BCS-Mac (Boston Computer 
Society Macintosh) Group. BCS-.Mac also has a nice 
fat PD catalog and a great monthly magazine. It's 
located at 1972 Massachusetts Avenue, Cambridge, 
MA 02140; (617) 864-1700. 

Of course, you can call Apple at 800-538-9696 for 
the name of your local Mac user group. 

VIRTUAL MEMORY 
Use Virtual Memory With Syquest Drives 
System Ts virtual-memory feature lets you operate 
with more memory than you have in physical RAl\1 by 
using hard disk space to swap memory blocks. You 
can't assign removable drives as the home for your vir­
tual R~\1, however. Fortunately, a freeware utility, 
VMEject, corrects this for owners of SyQuest remov­
able-cartridge drivers. 

WINDOWS 
Control Your Windows 
With a dozen windows open on your desktop, getting to 
the one at the bottom means a lot of shuffling. Instant 
Menus (QuickTools, Advanced Software, 1092 E. Duane 
Ave, Suite 103, Sunnyvale, CA 94086; 
800-346-5392) has a Windows feature that lets you 
instantly bring any open window to the front. Kiwi 
Power Windows Kiwi Power Windows (Kiwi Software, 
Inc, 6546 Pardall Road, Santa Barbara, CA 93117; 
800-321-5494) advances that concept by bringing any 
open window in any application to the foreground. 

WORD PROCESSING 

WORKS 
Apple Pro DOS-To-Mac '&anslation 
Need to deal with an Apple ProDOS-to-Mac-OS trans­
lation? The most common of these translations is 
necessary when you're transferring an Apple Works file 
to Microsoft Works. The standard way to do this is to 
save the Apple Works file on a 3.5-inch ProD OS disk 
and then use AFE (Apple File Exchange) with 
Microsoft's Works-Works Translator. The problem is 
that most Apple II-family computers have only 5.25-
inch-disk drives, and for AFE to do the conversion the 
source file must be on a 3.5-inch Pro DOS disk. 

Here's a workaround that doesn't require finding an 
available ProDOS drive. If you can get the Apple Works ~ 

179 ~ 



file onto a Mac disk by electronic transfer, you can get 
the file onto a 3.5-inch Pro DOS disk. 

Launch AFE, put in a blank disk, and choose ProDOS 
Fonnatting from the File menu. After the disk has 
been formatted, use AFE to "default copy" the 
AppleWorks file from the Mac disk to the ProDOS disk. 
Then make sure that the AppleWorks to Microsoft 
Works translator is available and checked in the 
ProDOS to Mac menu, and convert the file. 

GENERAL 
Underlining Words With Descended 
Characters 
There's not a whole lot you can do about poor 
underlining of letters with descenders- for exam­
ple, when you underline a word such as change and 
the g gets sliced through. Words with such letters in 
the middle look better if you change the offending 
letter(s) to plain text and leave the rest of the let­
ters underlined. 

MACWRITE 
Opening Mac Write Flies Without The 
Application 
Many software developers continue to use Mac Write 
format as their standard for on-disk program docu­
mentation. This can be inconvenient if you don't have 
Mac Write. You have to open up Microsoft Word or some 
other word processor and import the file, even if all 
you want to do is take a peek at the documentation. 

You could change Word's Creator to MACA, using 
ResEdit. However, if you're not comfortable with 
ResEdit or if text files are what you're after, there's a 
nice shareware utility, Read MacWrite, that opens 
Mac Write files and scrolls through them on the 
screen while saving the contents as a plain text file. 

Now if you need to take a look at some documenta­
tion on the fly, you can just open the file with aDA 
such as miniWRITER (which is also shareware). 

You can pause the scrolling, but Read MacWrite lacks a 
text buffer and elevator boxes for scrolling back over 
what you've read. Once the text has scrolled by, it's gone 
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until you reopen the file and start at the beginning. 

Read Mac Write's quick production of text files from 
MacWrite-formatted documents would also come in 
handy if you had several MacWrite files that you need­
ed to get into plain-text format in a hurry. (Read 
MacWrite is available in the Download Library Forum 
onZmac.) 

Save As '!ext When You're Exporting Hies 
While there are a few word processors that can't rec­
ognize and open MacWrite files (most notably 
Microsoft Word), in general you'll find it easier to 
export data to other programs or via modems by 
saving it as a Thxt Only file. The Text format is easily 
transmissible over ASCII data lines, and works well 
when you're transferring data to other types of com­
puters. 

Lack Of Disk Space Can Cause Printing 
Problems 
You can run into trouble trying to print documents if 
there isn't enough space on the disk to save the docu­
ment to the buffer. If your disk is too full to print, 
either delete some files or else transfer the document 
to a less-overburdened disk. In a pinch, you can print 
a few pages at a time. 

Hidden Spaces Can Affect Printouts 
If your text doesn't print correctly after you've set up 
tabs for columns, check problem lines or columns 
carefully to see if any spaces were mistakenly entered 
there. As soon as these inadvertent spaces have been 
erased, your printouts should come out spaced the 
way you meant them to look. 

Identifying Hookup Problems 
If you're getting the message that your document can't be 
printed, try again, watching the dialog box while the 
Mac tries to print. If the Mac displays the message 
"Looking for the ImageWriter/LaserWriter" for longer 
than usual and then tells you it can't print your docu­
ment, check all the connections to be sure the printer is 
hooked up correctly. 

Creating Flash Cards 
Here is a simple way to use the Mac to make flash cards. 
All you need is a program that prints two columns on a 
page (or you can do it the hard way and use tabs). 'fl1ese 
instructions are for using Claris' Mac Write II, but sophis-



ticated word processors such as Word, WordPerl'ec~ or 
Nisus work just as well. 

1 Create a format with two columns. Make sure that if 
the page were folded down the middle, the columns 
would be situated on either side of the crease. 

2 Type in the words or phrases in your target lan­
guage-let's say Spanish- in the left-hand column. 

3. Do a column break. Directly across from each Spanish 
word or expression, type the equivalent in English. Make 
sure that the equivalents are directly opposite each other, 
on the same imaginary horizontal line. 

4. Increase the space between the selections, either by 
double-spacing (pressing Return twice) or by increasing 
the line spacing. This step isn't essential, but the results 
look bette[ 

5. Print out the list You' 11 have a column of foreign words 
and phrases on the left and their equivalents in English on 
the right. 

6. If your printer has a sheet feeder, tum the paper 
over and run it through the printer again, head first, 
printing the other side. If you have a continuous form 
printer, make sure the paper is rolled to exactly the 
same point before printing each side. 

7. Cut the paper vertically up the middle. This yields 
two strips, each with English expressions on one side 
and their equivalents in the other language on the 
opposite side. Put one strip away to use if you make 
mistakes in the next step or if you later lose some of 
the printed phrases and want to make a new set. 

8. Trim off all the excess white paper. 

9. Cut the printed words and phrases apart, and mix 
them up. 

10. Whenever you want to test yourself, revie\V, or 
learn new expressions, just pull a slip of paper out and 
look at one side. After you've tried the translation, 
tum the paper over to see if you were correct. 

Nifty Smart Quote Feature 
MacWrite II has a nifty smart-quote feature that 
automatically converts the typewriter-style single­
and double-quote marks (like this:"") to the more­
professional-looking curly quotes. 

What do you do if you customarily use special foreign 

quote marks (such as guillemets in French, Italian, 
and German)? You can change Mac Write II to be 
smart in any language by changing the SMQT 
resource with ResEdit. Open the resource and substi­
tute the guillemets (both single and double) for the 
curly quotes. The keystrokes for < < and > > are 
Option-backslash and Shift-Option-backslash, 
respectively. The keystrokes for< and> are Shift­
Option-3 and Shift-Option-4, respectively. Close 
ResEdit and save the changes you've made. Now the 
program will smartly insert the new types of quote 
marks as you type. 

The 'Irick 1b Editing Footnotes 
If you place footnotes at the end of a MacWrite II docu­
ment, you will discover that the footnote page cannot 
be fully edited. That means that you cannot easily add 
a title, such as "REFERENCES," to the top of a page. 
Claris' technical support says that the official solution 
is to save the document as a text file, reopen it, and 
edit the final footnote page as needed. 

A better solution is to create footnotes in the usual way 
-in this case, auto-numbered and placed on the last 
page. Before you print, change your footnote prefer­
ences to disable the Auto Numbering option. Now place 
the insertion bar somewhere before the first footnote 
marker and insert a dummy footnote. 

When you are prompted for the footnote marker, use 
a space, which will be invisible in the body of the 
text. For the actual footnote, type the desired title. It 
will be unnumbered on the footnote page and will 
appear before footnote 1. You can edit this title/foot­
note to change its size, style, and ruler configura­
tion so it matches other titles in the document. 

If you want to add other footnotes to the paper after 
you have created the title/footnote, do not enable auto­
numbering. Instead, when the prompt for the footnote 
appears, press Return, and the appropriately numbered 
footnote marker will appear -without disturbing the 
title/footnote. 

NISUS 3.05 
Nonbreaking Spaces 
Sometimes you don't want a sequence of characters 
that includes spaces to break between lines at the 
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spaces (for example, in a mathematical equation). 
You can avoid this in Nisus 3.05 by using an Option­
space (called a nonbreaking space in other pro­
grams). To create such a space, hold the Option key 
down while you press the space bar. 

If you want to globally change the spaces within a 
selection to Option-spaces, you can do so by creating 
the following one-line macro: 

1. Choose New from the Macro submenu, on the Tools 
menu. 

2 Type the words "Find/Replace·; followed by a space. 
Type a pair of straight (dumb) quotation marks with a 
space between them. Type a second pair of quotes, this 
time with an Option-space between them. Type a final 
set of quotes containing an "s" (this tells the macro to 
replace the spaces in the current selection only). 

Your macro should look like this: 

Find/Replace " " " " "s" 

3. Save the new macro, and assign a key to it. Select 
the text that you want to change, and invoke the 
macro with this key. 

Zooming The Unzoomable 
Sometimes you might position a window on the 
screen so that its zoom box in the right corner of the 
menu bar (for resizing) is off the screen. However, 
Nisus lets you use the zoom box- even if it's off­
screen- simply by double-clicking on the window's 
title bar. This is true for all of your windows, including 
the Macro, Glossary and Catalog windows. 

Making Smart Quotes Stupid 
If you use smart quotation marks a lot, you should 
probably set up your Editing Preferences with Smart 
Quotes checked. Then whenever you type an ordinary 
quote (double or single), the correct curly quote will 
be substituted automatically. 

Sometimes, however, you want to insert straight 
quotes (when using the symbols for feet or inches, for 
example). Rather than going to the Editing 
Preferences menu and changing the settings each 
time, all you have to do is hold the Command key 
down while you type the quotes. Holding down the 
Command-key modifier reverses the Smart Quotes 
setting for that entry. 
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Doing Windows 
Here's a tip that's very useful if you have several win­
dows open simultaneously. 

Press the Command key, and click on the title bar of 
any window (including the Catalog and Macro win­
dows). The Windows submenu (which you ordinarily 
access on the Tools menu) will pop up and show you 
which windows are open. You can then access any 
window by double-clicking on its name on the 
Windows submenu. 

TEACHTEXT 
Placing Graphics In 'Ieach'Iext Documents 
Using The ScrapBook 
Using the Paste command to paste pictures into 
Thach Text documents doesn't work. Thach Text's docu­
ment-creation facilities aren't the greatest, but graph­
ics can be included. Here's how: 

- Collect all the pictures you plan to include in your 
document and save them in the Scrapbook. 

-At every place in your TeachThxt document that you 
plan to have a graphic, hold down the Option key and 
press the space bar. You won't see anything on screen, 
but a place will be reserved for your graphic. 

-When you're finished with the document, open both 
the document and your Scrapbook file with ResEdit. 
Res Edit will ask if you wish to create a resource fork for 
the ThachThxt document -you do. 

-Copy the pictures from the PICT resource in the 
Scrapbook file and paste them into the TeachThxt 
resource fork. Then select each picture resource, type 
Command-I to open an Info window on it, and set the 
resource ID of the first picture to 1000, the second to 
1001 and so forth. 

When you next open your Thach Text document, a pic­
ture should appear in each place where you entered 
Option-space. ThachThxt will center each picture, but 
you'll probably need to add some blank lines to open 
up white space for the pictures to occupy. 

Placing Pictures In 'leach 'lext Documents 
To place pictures in Thach Thxt documents, type 
Option-space where you want the picture to appear. 



The pictures must be stored as resources of type PICT 
in the document, copied there by ResEdit. The first 
Option-space is drawn as picture 1000, the second as 
1001, etc. Leave enough blank lines after the Option­
space so the picture does not cover the following text. 
To make the document read-only, change the file type 
to "ttro." Thach Thxt will display additional lines of 
credits while holding down Command-option and 
selecting About Teach '!ext. 

Placing The 'Ieach'Iext Newspaper Icon On 
Files 
Ever wonder how some of those little ThactThxt 
ReadMe files appear on the desktop as newspaper 
icons? It's really simple. 

1. Launch ResEdit or a similar program that allows 
you to edit the type/creator information of a file. 

2 Choose Get File/Folder Info from the File menu 
(that's how it appears in ResEdit 2.1; your version may 
be different). 

3. Choose the ThactThxt document file you want repre­
sented by the newspaper icon. The file type of normal 
ThactThxt files is TEXT, and the creator string is ttxt. 
Change the type to ttro, save your changes, and quit. 

4. Close the folder that contains your file, and reopen 
it. There's the newspaper icon! 

TEXT FILES 
Mac, DOS And Unix 'lext Files 
Mac text files ("text with line breaks," or some such 
in most word processors) terminate each line with a 
carriage-return character, while DOS text files use a 
carriage return and a line feed. Unix, of course, is dif­
ferent: It uses just the line-feed character. Programs 
that let you search for and replace non-printing char­
acters can be used to convert text files from one of 
these formats to another. 1\vo such shareware pro­
grams are Add/Strip and McSink, both available on 
ZiffNet/Mac or from your local user group. 

WORD 
Setting Predetermined Spaces 
If you find yourself restricted to a word-processing 
program for DTP after experiencing the relative luxury 
of a dedicated DTP product, you'll quickly begin to 
miss the ability to set predetermined spaces. Word, for 
instance, has a nonbreaking space, but that's it. 

You can, however, create spaces by "whiting out" 
characters of the desired width -namely, an em dash, 
an en dash, or any number (in most fonts, all num­
bers are the same width to aid in alignment). Here's 
how to do this in Microsoft Word: 

Type a dash or a placeholding number, select it, and 
choose White from the Character dialog box. You can 
assign a key combination to White and Black through 
the Commands option on the Edit menu, or .you can 
use a macro program to create the entire space. This 
technique greatly speeds up typesetting chores in 
which lots of specified spaces are needed. 

Dashes in text should have a tiny bit of space on both 
sides. Normally typesetters use one or two units, with 
units being defined as 1/18 of an em. You can create 
your own thin space in any program that allows you 
to print in white by using any punctuation mark, such 
as a period or a comma, that is the same width as a 
thin space. Store the entire dash-with-spaces combi­
nation in a macro, and you'll be able to provide the 
perfect dash instantly. 

In Show Paragraph mode, Word does not display white 
text as invisible, although the text does print that way. 

Discovering New Keyboard Combinations 
Sometimes while using Word, I accidentally discover 
new key combinations without knowing exactly what 
function they serve. Here's a quick way to find out the 
action of any key sequence: 

1. Choose Commands from the Word Edit menu. 

2. Pick any command from the list on the left, and 
click on the Add button in the Keys section of the dia­
logbox. 

3. Word will ask you to type a key sequence for the 
command you've chosen. Type the key sequence 
that performed the unknown action, and you' II get ~ 

183 ~ 



another dialog box telling you what command this 
key sequence is now assigned to. No more mystery, 
·-but be sure to click on Cancel to prevent reassign­
ment of the key. 

Mail Merge With The 'lltble Feature 
One of the worst aspects of Microsoft Word's mail­
merge feature is all the stupid punctuation rules 
you have to follow. Trying to make sure you have 
quotes and commas in all the right places often 
isn't worth the effort, and it can make inputting 
addresses sheer hell. 

If you use Word's Table feature to create the data 
documents for the merge, however, you can put the 
entire address- including commas and Return­
into one cell. Not only do you avoid having to 
enclose fields containing punctuation with quota­
tion marks but you also don't need to use as many 
fields, because all address information (company 
name, street, city, state, and ZIP code) is contained 
in one cell under one field name. Unfortunately, 
you can't use the Table format if you want to sort 
your data by its parts, such as by ZIP code or city. 

Fast Save Uses Disk Space 
Microsoft Word has a Fast Save feature, which lets 
you save files relatively quickly in exchange for 
greater disk-space consumption. 

\Vhen the Fast Save option in the Save As dialog box 
is checked, Microsoft Word doesn't actually delete 
text or graphics that you remove from a document; it 
just skips over them when you're displaying, editing, 
or printing the document. So, files don't get smaller 
when you delete things from them, and there is more 
overhead when you add new information. When you 
choose Save As and un-check the Fast Save check 
box, Microsoft Word actually erases all the deleted 
information, so the file size should decrease. 

Spell-Checking Without Putting The Cursor 
At Document Top 
It's possible to run your spelling checker on a Word doc­
ument without having to move all the way back to the 
beginning. First, select the entire document by moving 
the cursor to the left margin, where it changes into an 
arrow, and then click the mouse while pressing the 
Command key. When you run your spelling checker, 
the entire document will be checked in a single pass, 
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without the annoying "Continue Check from begin­
ning" message. 

Re-Spacing Between Letters 
Word creates its own "normal" spacing between let­
ters, based on the type and size of the font you're 
using. The problem is, sometimes the spacing created 
isn't exactly what you want. 

You can fix spacing between letters by selecting the 
text you want to change, choosing Character on the 
Format menu, and then selecting Expanded when the 
list of options appears. The program will suggest an 
expansion amount in the By box. Override this sug­
gested spacing by typing in any value from .25 to 14 
points. As you experiment with different results, you'll 
find the re-spacing that works best for you. 

Hiding Oudine Headings 
People who compose a lot of outlines will be vexed to 
find that most headings must be left out of the fin­
ished product. You can delete the outline headings 
manually, but in a long document this can be 
extremely time-consuming and can hinder your 
efforts to revise the file later. 

A solution is to use Define Styles to create a style sheet 
on which all outline styles are based. Its style would be 
the same as Normal Thxt. Using Define Styles again, 
you can define each of the subsequent outline styles as 
being based on this "normal" style by entering that 
name in the "based on" box. Now, any changes you 
make to the definition of the base style will automati­
cally be made to all outline styles. 

When you've finished composing and want to hide the 
outline, choose Define Styles and add Hidden Thxt to 
the style definition. All outline heads will vanish, 
unless you select Show Hidden Thxt. When you print 
documents created with this method, be sure Print 
Hidden Thxt isn't selected in the Print Dialog Box. 

Using Define Styles To Create Outline Styles 
A problem with Word's outlining capabilities is that 
there is no Hide Outline Headings command. Often, 
one wants to compose in an outline, but most head­
ings must be left out of the finished product. You 
could delete the outline headings manually, but this 
can be very time consuming in a long document and 
can also hinder future document revision. 



The solution is to use Define Styles to create a style 
sheet on which all outline styles are based. You could 
call this "base style." Its style would be the same as 
Nonnal Text. Again, using Define Styles, each of the 
subsequent outline styles should be defined as being 
based on this Nonnal style by entering that name in 
the Based On Box. Now, any changes made to the defi­
nition of the base style will automatically be made to 
all outline styles. 

When you have finished composition and want to hide 
the outline, choose Define Styles and add Hidden Text 
to the style definition. Thxt to the style definition. All 
outline heads will vanish (unless you select Show 
Hidden Text). When you print, make sure Print 
Hidden Thxt is not checked in the Print Dialog Box. 

"Auto-Date" Headers And Footers 
Anywhere In A Document 
When you paste "auto-date" headers and footers any­
where you want in your document, it continues to 
change automatically whenever you start a new doc­
ument. This is especially useful if you work from 
templates. 

The "auto-date" can be distinguished from text by 
using the Show Paragraph command (press 
Command-Y), which displays a dotted outline around 
all "auto-dates." 

This also works for time and page numbering. As an 
extra shortcut, try pasting "auto-date" into your glos­
sary and then add it to a menu. 

Key Strokes For Line Fonnatting 
In Word, the Return key is used to end a paragraph, 
while Shift- Return is used to end a line without creat­
ing a new paragraph. Shift- Return works fine as long 
as it isn't used in a justified paragraph. In the latter 
case, the line created with Shift-Return is justified­
something most people will want to avoid. And you 
can avoid it by pressing Shift-Option-Return. 

This undocumented method of concluding a line is 
very useful for lines within a justified paragraph that, 
for example, are to contain only a mathematical 
equation located at a center tab. It's also the only way 
to create the appearance of multiple justified para­
graphs within a single box. Simply apply the boxed 
fonnat to the paragraph and conclude each pseudo 
paragraph within the box with a Shift- Option-Return. 

The concluding line of each "paragraph" will not be 
fully justified. 

Incidentally, the Shift-Option-Return symbol that 
appears when Show is active looks just like the Return 
symbol. 

Condensing The Space Between Italicized 
Characters 
Sometimes Word puts too much space between itali­
cized words (especially if each word is capitalized, as in 
subheads or titles). Simply condensing italicized type 
usually results in squished type. But if you tum on 
Show from the Edit menu, you can select the space 
markers between the words and condense only them by 
using the Condense feature found in the Character 
dialog box. You can condense by anything from 0 to 
1.75 points. After you've highlighted the first space 
mark and condensed it, go on to the next space mark, 
highlight it, and press Command-A ('/\gain") so you 
don't have to reenter the values in the dialog box. 

Dialog Box Command Keys 
Word allows users to substitute command key combi­
nations for mousing in all dialog boxes. Any dialog box 
can be canceled by using Command-period. 

In The Save As ... dialog box: 

Command-S saves the file; 
Command-C cancels; 

In the Open ... dialog box: 
Command-O opens the highlighted file; 
Command-C cancels. 

In the OK or Cancel dialog box: 
Command-O presses the OK button; 
Command-C cancels the box; 

Creating Double And 'lliple Unes In Word 
Set Below and Double borders on the Paragraph selec­
tion under the Format menu to create a double line 
underneath a paragraph. For a really interesting 
effect, go to the paragraph directly below the double­
underlined one and set the borders for Double and 
Above. The results will be three horizontal lines. 

Placing A Background Screen Behind A 
Paragraph 
There are times when you may want to accent Word 
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paragraphs with a background screen. The following 
PostScript command, placed before a paragraph, will 
do the job: 

para. 0 0 moveto 0 1000 rlineto 1000 0 rlineto 0 -1000 
rlineto closepath gsave .97 setgray fill grestore 

'lltis instruction must be in PostScript style, which is 
one of Word's automatic styles and can be applied by 
entering PostScript in the Define Styles dialog box. The 
value 1000 will handle any paragraph up to 13 inches 
square, but if you want a smaller area, which will also 
print faster, you can pick a more realistic value by mul­
tiplying the number of inches by 72 and using that 
result. You can adjust the intensity of the gray scale by 
changing the .97 next to setgray. The closer this value is 
to 1, the lighter the screen. Word considers the space 
above and below your paragraph to be part of it, so 
some white space may get filled unless you use the 
Paragraph command and set this space to zero. 

Shortcuts When You "Save As ••• " 
There are a number of keyboard shortcuts you can 
take if youtl rather work through the keyboard than 
the mouse: 

Command-S saves the file. 
Command-E ejects the disk. 
Command-C cancels the dialog box. 
In the Delete dialog box, the same commands work, 
except that Command-S activates the Delete command 

Copying Parts Of A Style Sheet 
It's possible to copy one or just a few styles from one 
Word document's style sheet to another, without bring­
ing in the entire style sheet. First, open the document 
that contains the style(s) you want to copy. Select a 
paragraph that's formatted in that style (to copy several 
different styles, copy a series of paragraphs). 

Now, open the document to which you're going to copy 
the styles, and paste the paragraphs into the style 
sheet. TI1e new styles are now a part of the old style 
sheet. So nO\V, you can delete the text you pasted in, 
and the styles will remain in the document. 

Spell-Checking Around ligatures 
If you use a lot of fi and flligatures in long documents, 
you'll save time running the spelling checker by replac­
ing the character pairs "fi" and "fl" with the ligatures 
AFTER the spell-checking is completed. 
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The spelling checker can't recognize ligatures as 
alphabetic characters, and you can't add words that 
contain them to your dictionary. So, if you put the lig­
atures in before running the spelling checker, the pro­
gram regards any remainder of a ligature word to be 
misspelled- unless the remainder happens to match 
a word in the Main dictionary. 

After the spelling checker has finished running, go to 
the start of the document (Command-Keypad 9), 
open the Change dialog box (Command-H), set the 
replacement parameters, select Match 
Upper/Lowercase, and click Change All. 

Avoiding Disk-Swapping Hassles 
A lot of people use several different document disks 
during a single work session. If you do, and you work 
on a floppy disk-based system, you can avoid a lot of 
disk-swapping by double-clicking on the Word applica­
tion, instead of a document, when you start working. 

Correcting Pagination Problems With Serial 
Printer Drivers 
When you use the serial printer driver with either a 12-
or IS-pitch printer, you must first set the line spacing 
for all paragraphs, or the pagination will be incorrect. 
When you create a new document, first go to the 
Paragraph dialog box under the Format menu and set 
the line spacing to 12 points instead of the default 
spacing, "auto." 

If you are having problems printing an existing docu­
ment, select the entire text and then go to the 
Paragraph dialog box and do the procedure described 
above. 

Twelve is the proper setting to emulate a single­
spaced typewriter which produces 6lines per inch. To 
emulate other spacing, set a value of 72 divided by the 
number of lines per inch. 

Speeding Up The Graphic Redrawing 
Routine 
Word can take what seems like forever to redraw a 
complex graphic, especially one that has had 
smoothing activated for its curves. You can avoid 
this by creating a special Graphics style for each 
graphic, and including Hidden as one of its charac­
teristics. Make sure that your Preferences setting has 
Show Hidden Text set to Off. Now, you'll be able to 
quickly scroll through and edit text in the docu-



ment, without having to wait forever for graphics to 
redraw. 

Just remember to redefine your Graphics style by 
cancelling the Hidden characteristic before you print 
or repaginate. 

Printing Long Documents With Page 
Numbers 
The Word manual describes a rather involved proce­
dure for people who need to print long documents 
(meaning documents composed of several Word files) 
that have page numbers. One particularly annoying 
hoop you have to jump through is having to repagi­
nate each part of your document, finding out what its 
last page number is, and then having to set up the 
next file so that it starts with the next page number. 

There is a work-around to this situation. Choose Page 
Setup for each file, and type the file name of the next 
file, as the manual says. Then, WITH THE EXCEP­
TION OF THE FIRST FILE of the set of files composing 
the document, blank out the Start Page Numbers At 
box. That is, leave a 1 in the Start Page Numbers At 
box for the first file, and erase the 1 in that box for all 
the other files. Now, reopen the first file of the docu­
ment and tell the Mac to print. 

The entire document will print out with the right 
pagination, without your having had to repaginate 
each file. 

This only works if you begin printing with the first file 
of the series. If you print a file that appears in the 
middle or end of the set of document files, you'll have 
to follow the instructions in the Word manual. 

Cleaning Up Returns In Print Merge 
Documents 
When creating a list of names or addresses, for 
example, for print-merging in Word, making sure 
you have appropriately "Commanded" and "Shift­
Returned" each and every set of data can be unnerv­
ing. (Remember a Return is only entered at the end 
of each record, while a Shift-Return may be used for 
arranging the data more logically.) To eliminate 
most of the problem, you can use the Document 
Renumber command to number each set of data 
which isolates the entries with just a Return instead 
of the desired Shift-Return. Where you find the erro­
neous Return, put the cursor in front of the entry 

and press the Delete key, then press Shift-Return. 
Using the Document Renumber command also lets 
you know just exactly how many names or addresses 
you have. 

Ftnding The Missing Comma In Data 
Record 
'l11e easiest way to find a missing comma in a data 
record, while doing a Print Merge, is to select the New 
Document button in the Print Merge windO\v. This 
creates a document on the screen. When you come 
across the "Missing Comma in Data Record" dialog box, 
quit the Merge and scroll the document to the last record. 
The next record in your data file is the one with the prob­
lem. Once you have a successful Merge to the screen doc- · 
ument, select Print and you are assured of printing the 
entire batch successfully. 

When You Get The "Missing Comma In Data 
Record" Error Message 
Word's Print Merge capability requires that you sepa­
rate field names with commas or tabs. Unfortunately, 
when you accidentally omit one, the program simply 
puts up an error message, without telling you where 
your comma might be missing. Instead of going 
through each and every record you're working with, 
you can use this shortcut: 

Count the number of commas in the header record, 
and then use the Change command to systematically 
isolate the record that's missing a comma. You do this 
by entering a comma into both the Find What box and 
the Change To box. Then select sections of records 
and start searching. 

Word count11 the number of changes that it makes, and 
puts that number into the lower left corner. If the 
number of changes is not evenly divisible by the num­
ber of commas in the header record, you know that the 
defective record is somewhere in the records you just 
selected. If the number is evenly divisible, you can 
move on and select another section. 

Continue this process until you narrow down the data 
records sufficiently to isolate the one or more records 
with missing commas. 

Accessing Help Fast 
You don't have to dig out your manual every time you 
need help, if you have Apple's Extended Keyboard. The 
key, labeled "Help," is right under the F13 key. When ~ 
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you press it, you'll see a question mark appear. This is 
your cursor. Move it to whatever you want explained, 
including menu choices, and then just click the 
mouse for the help you need. 

If you don't have the Extended Keyboard, press the 
Command key and and the ? key to get the question 
cursor 

Using The ASCII Code Search-And-Replace 
Capability 
Microsoft Word has an ASCII code search-and-replace 
capability that can come in handy when using Word 
to edit and refom1at text files created on an IBM PC or 
PC clone. To find a particular ASCII code within a 
Word document, type a caret (Shift-6) followed by the 
decimal value of the ASCI I code in the Find What dia­
log box. Here's how to use this feature to fix a typical 
PC text file imported into the Mac environment 
(always work on a backup copy of the file you wish to 
convert): 

1. Select Change from the Search Menu (Command-H). 

2. Replace the double carriage-Return/ line-feed 
( CRILF) pairs at the end of each PC text paragraph 
with a special Mac character as follows. Click the I­
beam to the left of the first character in the file. In the 
Find What box, type " 13" 10" 13" 10" 03 is the deci­
mal value of the ASCII carriage-return code; 10 is the 
decimal value of an ASCII line feed). 

3. In the Change To box, type Option-S for a bullet or 
another special Mac character not used in the file. 
Click Start Search or Change All to make the changes. 

4. NO\v, replace the CR/LF codes at the end of each line 
within paragraphs with a space: With your insertion 
point at the top of the document enter " 13" 10 in the 
Find What box; in the Change To box, type one space; 
and then click Start Search or Change All. 

5. Finally, go back and replace the special Mac charac­
ters (used to mark the end of PC text file paragraphs) 
with a Return. First click the I -beam at the top of the 
file. In the Find What box, type a bullet (or whatever 
special character you used). In the Change To box, 
type "p (a caret followed by a lowercase p represents a 
Word Return character). Click Start Search or Change 
All as before. 

You can also use this ASCII code search feature to fix 
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PC word-processing documents within Word. For 
example, some PC documents contain normal text 
with only occasional ASCII control codes (such as 
decimal value 12 for fom1 feeds or 9 for tabs). Use 
FEdit Plus or another Mac file editing utility program 
to examine the codes in the PC document, and then 
use this technique to search for and delete these codes 
within Word. For a complete list of the decimal values 
for all ASCII codes, see the Appendix in the Microsoft 
Word manual. 

By the way, the reverse of this process works as well. 
You can replace return characters in a Word text file 
with ASCII CR/LF codes. TI1is allows you to create 
readable text files for your PC friends and customers 
without leaving your Mac. 

Slow Save In Word 
Other applications, such as Correct Grammar and 
Page .Maker, seem to hate documents saved with 
Word's Fast Save feature. If you want to eliminate the 
Fast Save feature in Microsoft Word, add the Fast 
Save Enabled option to the File menu using Word's 
Commands feature and then un-check it. 

'Ib accomplish this, choose Commands from the Edit 
menu in 4.0 and the Tools menu from Word 5.0. 
Scroll until you see Fast Save Enabled, and place 
this item in the File menu. Then select the Fast Save 
Enabled item under the menu you placed it in so 
that it does not have a checkmark next to it. 

Fitting Long Entries In Mail-Merge Fields 
As you're creating the data file, you might well find 
that some of your entries are too long or that they just 
don't fit the pattern you've established in the header 
information. You can get around this problem by 
breaking the field entry into two or more lines with a 
soft Return (Shift-Return). 

If you enter a soft Return, the mail-merge will bring 
that onto the next line without disrupting the field 
order. Be sure to save the data file as a normal Word 
document- soft Returns are stripped out of ASCII 
documents. To see the difference in a Word data file, 
just be sure that Show Paragraphs is on. 

Spacing Paragraphs In Styles 
One useful aspect of Word's style-sheet feature is its 
ability to assign a space before and/or after a para­
graph to a style. A space before and after in a style def-



inition lets you maintain consistent spacing between 
elements such as body text and section titles through­
out a document. 

If you assign Space Before to a style, however, and a 
paragraph with that style begins at the top of a page, 
Word adds the extra space at the top of the page, leav­
ing a gap. As a result, the top margin for that page 
appears to be shifted down, making it inconsistent 
with the other pages. Unfortunately, the only way to 
avoid this unwanted result requires manual labor: 

I. Place the cursor in the paragraph with the unwant­
edspace. 

2. With the Paragraph command, change Space Before 
to Opoints. 

Word removes the extra space at the top of the page. 

Note: Because page breaks can change while you're 
editing a document, it's wise to wait to make this cor­
rection until you're ready to print a final draft. 

Adding Words 1b A Dictionary 
Here's a relatively easy way to add large groups of 
words to Word's dictionary. Create a file containing 
the words you want to enter. Then select Spelling 
from the Utilities menu in Full Menus. Select the dic­
tionary to which you want to add the words. When the 
first word is queried, create a macro (with your macro 
program of choice) that clicks on the + button and 
then on the Continue button. Assign a keystroke for 
the macro, and press it as necessary as you continue to 
check spelling in the document. 

You' 11 find that this also makes your regular spell 
checking go faster, because you don't need to reach for 
the mouse when you add words to the dictionary. 

Managing Data With The 'lllble Feature 
An easy and straightforward solution to manage data 
in Word is to keep data in Word's tables. 

From scratch, simply type your merge field names on 
a single line, separating them with tabs. Select the 
line by pointing in the left area of the window and 
clicking once. Now, from the Document menu, select 
Insert Table, and accept the defaults presented to you. 
Your data is now in an easy-to-manage grid, one that 
changes height as you enter data. 

1b enter data, click on the last cell in the row and 

press Return - a new row is started, and you can start 
entering your merge data. 

If you don't like the column widths, you can change 
them: Click on the Ruler icon in the ruler, and T mark­
ers appear; shift these markers around until the table 
suits you. You can also change the page setup to land­
scape instead of portrait, because only the characters in 
your table - not their format -will be merged. 

If you're merging from a database such as one pro­
duced in FileMaker, the process is even easier: Select 
the entire document you've exported from your 
database (Command-click in the selection bar or press 
Command-Option-M), and choose Insert Table from 
the Document menu. FileMaker can output data in the 
exact format Word needs to produce a merge docu­
ment, and the Table feature organizes the information 
so that you can see what you have without having to 
wade around in all those defaulted tabs. 

Tune-saving Indexing 
To use Word's indexing feature, you must mark each 
word that you want to index with i. in front of the word 
and ; after it. This is extremely time-consuming, 
especially if you want to index a word every time it 
appears in a document. Here's an easy way to add 
hidden.i. and; characters around all occurrences of a 
given word in an open document: 

1. Index the first instance of the word as you normally 
would. Choose Save As from the File menu. 

2. In the Save As dialog box, click on File Format and 
choose Interchange Format (RTF). Click on OK. 

3. Give the RTF document a name, and save it. You'll 
see a new version of the file with all kinds of strange 
control codes embedded in it. 

4. Find the first instance of the word that you indexed 
normally. it will be surrounded by codes that might 
look something like this: {\v {\xe\pard\plain\s240 
Indexwork}}. 

5. Select the word and all of this index code -which 
always starts with {\v and ends with}}- and copy 
the selection to the Clipboard. Next, place your inser­
tion point after this word and all the code that sur­
rounds it. 

6. Choose Change (Command-H) from the Utilities 
menu. Type the word you want to index into the Find ~ 
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What: box, and then paste the contents of the 
Clipboard into the Change To: box. 

7. Click on Start Search (choose No when Word asks 
you if you want to continue the search from the 
beginning of the document). This will add the correct 
index codes at the beginning and end of each occur­
rence of the word you want to index. Repeat this pro­
cess for all words you want to index. 

When you've finished, save and close the RTF docu­
ment. When you reopen the document, Word will ask, 
"Interpret RTF text?": click on Yes. The document will 
then appear in normal fonnat with all the relevant 
entries properly indexed. You can verify that all the 
words have been correctly labeled by choosing 
Preferences from the Edit menu and toggling the 
Show Hidden Text button on. You can then create an 
index for the document as normal, using the Index 
command, on the Utilities menu. 

The Word Screen Saver 
Ordinary screen savers may dim your screen or offer 
fireworks and clock displays, but in Word 4.0 and later, 
there's an animated display that is quite beautiful in 
color. Select Commands from the Edit menu and 
choose Screen Thst from the list of commands in the 
dialog box. Click on the Do button. If you click once 
while the images are dancing across the screen, a dia­
log box will let you customize the display or cancel it. 

Formatting Ftelds From A Database Using 
The Mail-Merge Function 
Most database programs can export to PageMaker (and 
other desktop publishing programs), but fonnatting 
text with anything but paragraph-based styles is diffi­
cult. (For example, you might want one field to come 
out in bold, one in italic, and one in a different font 
than the rest). The answer is to use Word's mail-merge 
function. Fonnat the main document as desired, using 
the field names from your database; for example, you 
could boldface the name field and italicize the phone 
field, as shown here: <<DATA Data document>> 
<<Name>> tab <<Address>> tab <<Phone no>> 

Export your database to a tab-delimited ASCII file, 
and set this exported file up in Word as a data docu­
ment. Then you can enter the field names in the data 
document. 

Make sure that no commas appear within the fields 
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(you can search for commas to be certain). 

Go to the main document, choose Print Merge from 
the File menu, produce a new document, and use the 
Change command to get rid of the page breaks 
between entries. You can now import the fonnatted 
Word document into PageMaker or any other page­
layout application. 

Creating An On-Line Hints Menu 
Word users have been inundated with documenta­
tion, help files, and third-party books discussing all 
the program's intricate features. Trying to keep track 
of all this information in its present state is mind­
boggling but worth the effort. 

To have this information literally at your fingertips, 
create a file named Hints in which you store a per­
sonalized set of commands, shortcuts, and tricks 
that you want to keep at your fingertips. Give this 
Hints file menu-bar status by adding it to the Work 
menu. Press Command-Option-+ (plus symbol). 
When the cursor turns into the plus symbol, click on 
your Hints document, either in the Open dialog box 
or in its title bar (if it is the active document). 

Word will create a Work menu on the right-hand side 
of your menu bar or add your Hints document to an 
existing Work menu. 

Launching Mac Write Documents With Word 
Whenever you double-click on a plain-text MacWrite 
document (such as the documentation files you 
download frequently from bulletin boards), it won't 
open unless you have Mac Write on your disk. As a lot 
more people use Word 4.0 than MacWrite, here's a way 
to make Word 4.0 automatically open those MacWrite 
documents in its own fonnat when you double-click 
on them. 

First, make a backup copy of Mac Write (if you have it 
installed) on a floppy and then delete it from your 
hard drive. 

Next, make a duplicate copy of Word 4.0 on the hard 
drive and rename it MacWord. 

By using ResEdit, you can change the Creator of 
MacWord from MSWD to MACA (higl1light MacWord 
and choose Get Info from the File menu). Make the 
changes in the Creator box. 

Now, when you double-click on a MacWrite document, 



MacWord will launch and the document will be con­
verted automatically. 

Quickly Adding Fonts To Word's Font Menu 
If you need to add font names to Word's Font menu 
pressing Command-Option-+ each time can get ' 
tedious in a hurry. Here's a fast, undocumented way to 
add all the currently installed fonts to your menu. 

Choose Commands from Word's Edit (Tools in Word 
5.0) menu, and choose List All Fonts from the list of 
commands. Then click on the Do button. 

The menu bar will flash as Word adds Suitcase fonts 
one at a time to the Font menu. 

Using Insert Graphic To Speed Printing 
Tune 
Inserting a graphic in a word-processing document 
can significantly increase printing time. Here's a trick 
for trimming your printing time on working drafts 
and proofs. 

Measure the illustration's height (many object-oriented 
draw programs have a Show Size option). Insert the 
graphic into a Word document. With the graphic select­
ed, choose Paragraph from the Format menu. Type a 
minus sign in the Line Spacing box and then enter the 
graphic's measurement. The minus sign adjusts the 
paragraph's height to match the size of the graphic. 

Select the graphic again, choose Character from the 
Format menu, and format the graphic as hidden text. 
When you print draft documents, be sure Print Hidden 
Thxt in the Print dialog box is not selected. The illus­
trations will be replaced by an appropriate amount of 
white space, and you'll know where your page breaks 
are. When you're ready for the final version, recheck 
Print Hidden Thxt, and the graphics will print properly. 

Printing Grey 'Iext 
Microsoft Word lets you assign one of eight basic col­
ors to text. Most users don't have access to color output 
devices, and if they do, they probably don't want to 
print those overripe colors anyway. 

But there's a clever application of this feature that 
almost everyone can use. If you color text and then 
print to a laser printer with Version 6.0 or later of the 
LaserWriter driver, the text is halftoned. The order of 
grey-scales, increasing in darkness, is Yellow, Cyan, 
Green, Magenta, Red, Blue. 

Customizing Word To Open The Ruler 
Automatically 
You can make your documents open with the ruler 
automatically displayed by using Commands from 
the Edit menu. Here is how to do it: 

1. Open any Word document. Make sure Full Menus is 
selected. 

2. Choose Commands from the Edit menu. 

3. Make sure the dialog box says "Configuration: Word 
Settings ( 4)" in the lower left comer. This tells you the 
name of the file you are customizing. 

4. Scroll down the command list until Open 
Documents With Ruler show up. (Shortcut: Press the 0 
key to jump to the beginning of the 0 listings.) Click 
on the command name to select it. 

5. Click on the Add button. 

6. Click on Cancel. 

The Open Documents With Ruler command will now 
be listed on the Format menu. It will not be checked 
though, so you will have to activate it. Highlight the' 
new menu command to select it. Every document you 
open from now on will automatically show the ruler. 

It's worth looking through the entire list of com­
mands in the Commands dialog box, since many use­
ful items are tucked away in there, and some of them 
are not documented in the Word manual. 

Accessing The Macron Character 
In most Adobe laser fonts, you can access a plain 
macron character by pressing Shift-Option-comma 
(although the macron may not show on-screen if you 
do not have the appropriate screen font). 

Microsoft Word's formula language allows you to over­
strike one character with another, placing a macron 
over long vowels. 

To put a macron over the desired vowel, type the 
Formula character, Command-Option-\ (it may not 
be visible if the paragraph markers are hidden). If you 
get a beep instead of the Formula character, select Full 
Menus from the Edit menu. 

Next , type an 0 for Overstrike, and then type ( and 
the character you want to have the macron. Finally 
type a comma, the macron and). 
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A Macro For 'lhutsposed Characters 
You can design a macro for Microsoft Word that trans­
poses two letters accidentally typed in the wrong 
order, a common typing error. There may be a draw­
back to this method if the macro uses the standard 
Cut and Paste commands, because it empties the 
Clipboard. Here's a macro that does the job without 
using the Clipboard. 

First, be sure that Num Lock (toggled by the Clear key) 
is off- the status box in the lower left comer of the 
active window should not read Num. Lock. Now begin 
recording your macro. (The macro assumes that 
you've placed the insertion point just after the second 
mistyped letter.) Press Shift-keypad-4, which high­
ligllts the second letter. Next, press Command­
Option-X (the status box will now read Move To), and 
then press the keypad 4 twice, which moves a flashing 
gray vertical line to the spot just before the first letter. 
Now press Return, and then move the insertion point 
back to its original spot by pressing the keypad 6 once. 
Stop recording and assign a keystroke. 

Globally Replacing Fonnats 
There are two indirect ways to globally find and 
replace fonts or formats in Word, for example, if you 
want to be able to change underlined text in a file to 
italicized text. 

The first is to convert the document into RTF (rich 
text fonnat). To do this, choose Save As from the File 
menu, click on the File Fonnat button, and choose 
Interchange fonnat (RTF). When you save the docu­
ment, it appears on screen complete with the fonnat­
ting code. Because the code for underlined text is \ul 
and the code for italici7.ed text is \i, you can globally 
change the fonnatting by using the Change command 
(Command-H). In the Find What box, type \ul; in the 
Change To box, type \i; and then close the document 
and save your changes. When you reopen the docu­
ment and Word asks if you want to interpret RTF text, 
click on OK. All underlined text is now italicized in 
the new (untitled) document. 

The other way to do this is to use the obscure Find 
Fonnat command, described in the Word manual. It 
let<; you search for underlined text, but you have to 
change it to italic manually. 

Here's how it works: To find each occurrence of under­
lined text, first select an underlined character. Invoke 
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Find Fonnats by pressing Command-Option-R, and 
the program finds and selects the next occurrence of 
underlined text. Change it to italic by choosing Italic 
from the Format menu (or type Command-Shift-1). 
1b find the next occurrence of underlined text, choose 
Find Again from the Utilities menu (or type 
Command-Option-A). 

This procedure isn't global; however, it does what you 
want fairly easily. If global-format changing is impor­
tant to you, you should know that other word proces­
sors do it faster and more easily. MacWrite II, for 
example, does it with a few simple selections in its 
Find/ Change dialog box, and Nisus and FuiiWrite 
Professional work similarly. 

Ask yourself how much pain Word's lack of a Change 
By Style feature causes you; if it's really affecting your 
quality of life, think about changing word-processing 
programs. 

Speeding 'lllble Scroll 
When you're working with a table-laden document in 
Word, it can take forever to scroll through the table 
sections. If you frequently use tables in your work, 
here's a trick that can eliminate scroll crawl: 

1. Select the entire table, and choose Copy as Picture 
from Commands in the Edit menu (and while you're 
at it, place this command on your Edit menu). Click 
on Do. 

2. With the table still selected, perfonn a Paste 
( Command-V). The text table will be replaced by a 
graphic version of the same table. Now that the table 
has been changed to a graphic, you can scroll it 
much faster. 

3. Go back to the Commands menu and choose Use 
Picture Placeholders (you can add this to the Edit 
menu as well). Click on Do. 

Caution: If you ever expect to revise the table, you 
should first save a copy of the text version in a sepa­
rate file. Once you have replaced a table with its 
graphic image, you can no longer edit it, with one 
exception: You can cut rows from the bottom up and 
columns from right to left if Show Paragraph 
( Command-Y) and Use Picture Placeholders are off. 
just grab one of the handles on the graphic and drag 
to crop it. 



Add The Pctst Save Enabled Command To 
The File Menu 
The Fast Save command increases the speed of the 
Save command, thereby making it less painful to save 
your files frequently. When you use the Fast Save 
Enabled command, Word saves files in a special file 
fonnat that's fine for saving work in progress. Fast 
Save isn't suitable for final versions, though. If files 
saved in this fonnat are damaged, it's much harder, if 
not impossible, to recover them. 

Placing Fast Save Enabled on the File menu makes it 
easy for you to select or deselect the command before 
you save. Word's default option is to add this com­
mand to the Edit menu, but it makes more sense to 
add it here. 

To add the Fast Save command, choose Commands 
under the Edit menu and look for the Fast Save 
Enabled option in the scrolling field on the left. 
Highlight it, and choose the File menu and click the 
Add button. (You may have to remove the command 
from another menu before adding it to the File menu.) 

Add The Make Backup Files Command To 
The File Menu 
Nonnally, each time you save your work, the new ver­
sion of your file overwrites the previous version. When 
you select the Make Backup Files command, however, 
Word makes a copy of the previous version of your file 
and names it Backup of Filename before executing the 
save. As a result, you always have the last two saved 
versions of your file on-disk. This means that you can 
go back to the previous version of your file, and you 
also have a backup in case something happens to the 
current version of your file. 

To add the Make Backup Files command, choose 
Commands under the Edit menu and look for the 
Make Backup Files option in the scrolling field on the 
left. Highlight it, and choose the File menu and click 
the Add button. 

Add The Load File Into Memory Command 
To A Menu 
This command, which is nonnally in the Preferences 
dialog box, causes Word to keep the current document 
in RAM rather than keep only the currently displayed 
portion of the file in RAM and read the rest from disk as 
you scroll the file. If you're going to be scrolling up and 

down within your file frequently or executing com­
mands that require Word to access the whole document 
(such as Spelling, Hyphenate, Repaginate Now, or 
Print), keeping the file in RAM can speed up Worrl's per­
fonnance. 

If you always work on files for long periods, you may 
be better off checking the Always Load File into 
Memory option in the Preferences dialog box rather 
than adding this command to your menu. However, if 
you sometimes open and close files without perfoml­
ing extensive editing, using this option as a command 
is more efficient. 

Add The Move To Commands To A Menu 
Word provides an exhaustive array of cursor-move­
ment commands that most users never discover. If 
you use the arrow keys to scroll across your files, 
learning to use these commands can give you a whole 
new perspective on word processing. 

Once you are familiar with the commands, learn the 
keyboard command equivalents for real efficiency. You 
can also use these commands to select text; just add the 
Shift key to any of the keyboard command equivalents, 
and text is selected as you move the cursor. 

To add any of the Move To ~ommands, choose 
Commands under the Tools (or Edit menu in Word 4) 
menu and look in the scrolling field on the left. 

Add The Select Whole Document Command 
To The Edit Menu 
People often want to select an entire Word document, 
but it's hard to remember the keyboarrl command 
equivalent (Command-Option-M) or inconvenient to 
use the mouse-click method (Command-click with 
the arrow tool at the far left edge of the window). With 
the Select Whole Document command in the Edit 
menu, selecting an entire document is no longer a 
brain-teaser. Interlace purists will also want to assign 
it the Option-A keyboard equivalent. 

Recovering Word 'Iemp Files 
Before you save a Word document, Word sets up a tem­
porary file and places it in the System Folder. If your 
system has crashed and you want to try recovering a 
Word Thmp file, you can try opening it by holding 
down the Shift key and choosing Open Any File from 
Word's File menu. That should enable you to open the 
Thmp file (try the one with the highest number). If 
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you want to, you can add the Open Any File command 
to your menu permanently by using Word's command 
option, which you'll find on the Edit menu. 

WORD 4.0 
Changing The Default Font 
There is an easy way to change the default font in Word. 
Choose Define Styles from the Fonnat menu, click on 
the Normal style, pull down the Hmt menu (or type 
Command-O), choose the font you want and click on 
the Set Default button. A dialog box will confirm that 
you want to record your choice to the default style sheet. 
Click on OK. That's it- your default font is changed. 

Indexing 'Iechnique Using The Clipboard 
Here's an easy technique that you can use for indexing 
all occurrences of a word. 

Start by manually indexing the first occurrence, using 
Insert Index Entry, on the Document menu. Then 
select the word (make sure you include the index 
characters that appear at the beginning and end of 
the word), and copy it to the Clipboard. In the Change 
dialog box (Command-H), type the word you want to 
index in the Find What Field and type Ac (caret and 
c) in the Change To field (A c represents the Clipboard 
contents). Replace all nonindexed occurrences of the 
word by clicking on either the Change or the Change 
All button. The pasted text retains all fonnatting. 

Using Word Fmder With System 7 
If you use System 7 and Microsoft Word 4.0 or a later 
version, you've probably already discovered that you 
can't use the Word Finder thesaurus DA that comes 
bundled with Word. Because of the way System 7 han­
dles DAs, Word Finder gets confused when it looks to 
see if Word is running. 

There is a workaround for this problem, however. 
(Note that this procedure should be perfonned only on 
a copy of the Word application- never experiment 
with the original program!) 

First, open the Font/DA Mover utility. (You need 
Version 4.1 if you're ~unning System 7. If you have 
only an earlier version, boot from a System 6 floppy 
disk and follow the rest of the directions.) 

Open the Word Finder DA suitcase file on the left side 
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of the Font/DA Mover dialog box. Hold down the 
Option key while clicking on the other Open button, 
and open Microsoft Word on the right side of the dia­
log box. Select Word Finderl and copy it into the Word 
application. Now quit Font/DA Mover. 

Nmv, whenever Word is the active application, the Word 
Finder DA will appear on the Apple menu and function 
properly. 

Inserting Graphics Into A Print-Merge 
Document 
You may be familiar with Word 4.0's Print Merge fea­
tures, which allow you to generate fonn letters by 
using data exported as text files from database pro­
grams. But you aren't limited to using text files for 
your data document; you can also use Word docu­
ments fonnatted as tables in which each row is a 
record and each column is a field. 

One advantage of this method is that it lets you 
include graphics in your data document. For exam­
ple, to include your scanned signature in documents 
to be sent by fax modem, put it into a table cell in 
your data document instead of pasting a copy into 
each file. Then set up the main document to be 
faxed as a print-merge document. Your signature 
will automatically be "scribbled" on each page. 

Use PostScript To Control Cell Border Width 
In 'lllbles 
Word 4.0 has a great table feature, but only limited 
border options for each cell. All it takes is a little 
PostScript programming, however, to make a cell bor­
der of any width. Place the cursor in the cell that you 
want the border around, and type the following two 
lines: 

.cell.. 75 setlinewidth 

wp$box stroke 

and press Retum. 

Then highlight only these lines (not the actual con­
tents of the cell to be printed), and fonnat with the 
PostScript style by pressing the Shift key and choosing 
All Styles from the Fonnat menu. Select PostScript in 
the scrolling list that appears, and click on Apply. 

The number .75 can be replaced with any number of 
your choice. Make sure you've deselected Print Hidden 
Thxt in the Print dialog box before you print. Note that 



Print Preview doesn't accurately reflect your actual 
hard-copy output. Also, this tip works only if you are 
printing to a PostScript printer. 

Combining Box And Check Mark Zapf 
Dingbats 
Here's how to put a Zapf Dingbat check mark into a 
box with a drop shadow: 

1. Press Command-Y to see the symbols for para­
graphs, spaces, and tabs. 

2. Press Command-Option-Backslash, and then 
type 0(0,4). 

3. Select the text (including the backslash), and 
choose Zapf Dingbats from the Font menu. Press 
Command-Y again to hide the paragraph and space 
symbols. You now see a box containing a check mark. 
You can experiment with the various boxes and check 
marks in Zapf Dingbats until you have a combination 
you like. 

Boxing In text 
Just about any currently available word processor 
offers a variety of ways to format words to make them 
stand out from the main body of the document. But 
what do you do when underlining or boldface or even 
something as exotic as a shadow doesn't fit the bill? 
Try a box! Here's how: 

1. Select and format the text to be boxed. (Note: After 
it's been boxed, the text itself can't be reformatted.) 

2. Use Command-Option-D to copy the selection to the 
Clipboard as a graphic. 

3. While the text is still highlighted, use Command-V 
to replace it with the graphic image of the copied 
selection. 

4. Click on the graphic to select it, and box it in by 
choosing the Outlinestyle from the Format menu 
(Command-Shift-D). You can also add shadow 
or boldface format to the outline style for extra 
emphasis. 

The secret here is that the style commands don't work 
just with text- which is what most people assume -
they also work with graphics. 

If the boxed text is on a line with other text, it will sit 
higher, because the bottom of the box sits even with 
the baseline of the text on that line. To correct this, 

select the graphic, choose the Character command 
from the ~onnat menu (Command-D), select sub­
script, and offset the text as needed (the larger the 
font size, the greater the offset required). 

Using Postscript Code to Shade A Cell 
You can use PostScript code to shade a cell in a Word 
4.0 table by typing: .cell .. 75 set gray wp$box fill and 
pressing Enter. Then select the text, and format it with 
the PostScript style by pressing the Shift key and 
selecting Define All Styles from the Format menu. You 
can replace the number .75 with whatever number 
you choose. Make sure that you have deselected Print 
Hidden Thxt in the Print dialog box. 

Viewing Landscape 'Ihbles 
Here's a tip for creating full-page landscape-oriented 
(horizontal, not vertical) tables in Microsoft Word 
when using a small-screen Mac. This tip avoids the 
constant (and painfully slow!) screen redrawing 
that occurs when the cursor moves past the edge of 
the currently visible portion of the table. 

1. Create your table. After you've created the column 
headings and table layout, use the Insert Row com­
mand to specify the number of rows. 

2. Resize the window you're working in so that it fills the 
entire screen horizontally but only half of the screen 
vertically. Place the window at the top of the screen. 

3. Now open a second window for the table; don't split 
the window you're working in -open a new one. 
Resize the new window so that it fits just underneath 
the original one. 

4. Use the horizontal scroll bar to shift the view in the 
new window so that you can see the right edge of the 
table. 

Now you can see your whole table - the top window 
shows the left edge of the table and several of the 
columns toward the middle; the bottom window shows 
the right edge of the table and some of the same mid­
dle columns. 

Enter the table information. When you've finished 
with the last fully visible column in the top window, 
use the mouse to move to the column following it in 
the bottom window. When you get to the right edge 
of the table, use the mouse to move back up to the 
next row in the top window. 
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This is a much quicker and more accurate method 
of creating a table - you never have to wait for the 
screen to redraw while you're typing, and you never 
lose your place because you can't see the row head­
ers at the left edge of the table. 

Sorting A Mail Merge 
Do you want to sort a mail merge data file by zip code 
when the first field is I.&INAME and ZIPCODE is some­
where in the middle of the record? You can try using 
Option-drag to select just the ZIPCODE column. You 
need to set your tabs so that all the zip codes are left­
aligned in a column. Hold down the Option key as you 
drag the mouse to highlight the desired column of text. 

Once you've selected a column of text, using the Sort 
command sorts the records based on the first word of 
each line in the selected column rather than on the 
first word of each paragraph in the data document. 
And remember not to select the field name at the top 
of the document. 

Using Outlining 1b Navigate 
Word 4.0's outline feature is frequently underused, 
probably because most people don't make outlines. 
But this feature can be helpful for more than out­
lining. 

Here is a way to jump quickly to a specified place in a 
long document: 

1. Select Outlining mode (Command-O) from the 
Document menu. 

2. Click on the line of paragraph you want to go to 
(collapsing or expanding as needed). In effect, you're 
creating a kind of bookmark by entering an insertion 
point. 

3. Choose Outlining again to go back to normal edit­
ing mode. Now your cursor is at the right spot, but it's 
probably off-screen. 

4. Press the right- or left-arrow key to scroll the document 
to the cursor's location. 

Using The NEC Daisywheel Printer 
If you use Word 4.0 and a NEC daisywheel printer, you may 
find that the 12th line of te:-.1 on a page often prints over 
the 11th line. This didn't occur with earlier versions. 

You can count down lllines and then insert a blank 
line to overcome the problem, but there is a better 
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solution. The NEC printer uses a pitch of 12, so if 
you choose the Paragraph command from the 
Format menu ( Command-M) and replace Auto in 
the Line Spacing box with-12, the overlapping stops. 

Creating 'lllbles With Varying Column 
Widths 
The Insert lable command in Word 4.0 only lets you 
create table with columns of equal width. Ordinarily, 
you have to struggle with the column markers across 
the ruler to vary the column widths, but there is a 
shortcut that makes it easy: 

1. Say you're creating a three-column table with one 
narrow column on the left for labels and two wide 
columns to the right for entries. As you create the 
table, enter 5 in the Number of Columns box. 

2. Select all the cells in the second and third columns 
by holding down the Option key while dragging the 
mouse over these columns. 

3. Choose Table from the Edit menu and select the 
option for merging the two columns. Repeat this pro­
cedure with columns 4 and 5. 

You now have a three-column table. To get a narrower 
first column and wider entry columns, just increase 
the number of columns in the table by a factor of 2 

A Patch For Fractional Font Widths On 
ImageWriters . 
If you do not own Adobe Type Manager, and you are 
using Microsoft Word, there is a patch -a set of 
modifications to Word - that allows for fractional 
font widths on ImageWriters. It's called 
WORD4MOD.SIT. (It should be available from the , 
usual shareware outlets such as user-group libraries, 
BBSs, and so on. On CompuServe it's called WORD­
MO. BIN in the Macintosh Productivity Forum's word­
processing library.) 

Installing the patch requires familiarity with ResEdit 
(available from the same outlets). Obligatory ResEdit 
waming: Never use ResEdit on an original or master 
of anything. Always work on a copy. And don't forget to 
lock your master disks. That way, if you happen to 
make a mistake and damage something, you can 
always make a fresh copy from the master disk. 

Kerning With The Displace Command 
Microsoft doesn't mention kerning anywhere in the 



Word manuals, but you can do rudimentary kerning 
with two characters: 

1. Choose Show from the Edit menu. 

2. Place the cursor between the two characters you 
want to kern. 

3. Press Option-Command-backslash and then type 
the letter D (the formula code for Displace). 

4. Press Option-Command-backslash again, and then 
type the letters BA (the formula code for Backward). 

5. Enter the number of points to kern (in whole 
points). 

6. Follow this with both open and close parentheses to 
end the formula. The code you see on-screen should 
look like this: \d\ba3 () (using 3 points as an example). 

7. Choose Show again or print your text, to see the dif­
ference in spacing. If you save this formula as a 
Glossary item, you'll have to enter it only once. 

Inserting The Date Into Documents 
Word lets you insert the date into documents through 
its Commands dialog box, but you're stuck with its 
date formats, which include the day of the week 
(except for the short format - for example, 3/31/89 ). 
If you want a date such as March 31, 1989, you'll have 
to suppress the weekday in the System file with 
ResEdit 1.2. (Try this on a copy of your System file 
before you change your working System file.) 

1. Open the System file and scroll down to itll. 

2. Open itll. Select itll US" ID=O and open it. 

3. Next, click on the Suppress Day box (see Figure 2). 

4. Close ResEdit and save the changes. Open a Word 
document. To get the date, make sure you're using Full 
Menus and select Glossary from the Edit menu. You'll 
see the following date entries: date - now - abbreviat­
ed, date - now -long, and date - now -short. 

Select either the long or the abbreviated format and 
click on Insert. The date will appear either as March 
31, 1989, or as Mar. 31, 1989, respectively. 

Inserting PostScript Code In A Word 
Document 
Placing bits of PostScript code (or even lengthy rou­
tines) into a Word document is simple. But Word 

requires that you first clearly define what part of the 
page will be affected by the PostScript code. Is it going 
to affect the entire page (for example, a box enclosing 
the page) or just a paragraph or inserted graphic? 

You define the boundaries by inserting a group com­
mand immediately before the page element it will 
affect. In Word 3.02, you could use three such com­
mands: .page., .para., or .pic. (referring to the entire 
page, the next paragraph, or the next graphic inser­
tion). Version 4.0 has added .cell. and .row. to facili­
tate PostScript manipulation of tabular material. 

1. Group Command'i- Group commands create a 
drawing rectangle that specifies the overall size of a 
PostScript graphic. The actual dimensions of the 
graphic never have to be entered, because the com­
mand gathers this information from Word itself. The 
drawing rectangle created by .page., for example, is 
determined by the page size you've specified with the 
Page Setup command. If your page is 5 x 7 inches, the 
drawing rectangle mirrors those measurements exact­
ly. Most other group commands, such as .para. and 
.pic. let you focus on increasingly smaller or more pre­
cise areas of the page - a paragraph, or a graphic 
frame within a paragraph. 

Mter the group command is entered, you can enter 
PostScript code you've written or copied from another 
source. Here's a simple example that places a 5 x 7 -
inch box on a page. At the top of the page, type the 
following: 

.page. 

newpath 

.25 setlinewidth 

126 144 moveto 

360 0 rlineto 

0 504 rlineto 

-360 0 rlineto 

closepath 

stroke 

Anyone with PostScript savvy will notice some pecu­
liarities here. The primary one is that the PostScript 
inclusion hasn't been bracketed by a save /restore or 
gsave/grestore pair, which prevents certain PostScript ~ 
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operators (rotate, for example) from changing the 
graphics environment of the entire page. Why this 
apparent breach of PostScript etiquette? Because the 
group commands automatically bracket each group­
ing of PostScript code with a save/restore couplet. 

You might also notice that the origin point (0 0) in 
Word's version of the PostScript coordinate system cor­
responds exactly to that found in PostScript itself. 
This means that the origin point (0 0) is found at the 
lower left corner of the current drawing rectangle, 
whether it is a page, paragraph, or graphic frame. 

2 Creating Global Commands-When PostScript 
requires specific measures or positions that can't be 
referred to through the built-in variables, the dimen­
sions are expressed in points. If you feel more comfort­
able working in inches, simply place the following code 
after a group command such as .para. or .page. (and, 
of course, format it in Word's PostScript Style): 

/inch (72 mul) def 

Then you can use code such as I inch 1 inch moveto 
instead of 72 72 move to. The routine you've inserted 
automatically multiplies the inch units by 72, convert­
ing them into PostScript's point system. 

Ordinarily, such a routine applies only to the drawing 
rectangle indicated by the group command. So if you 
had a .page. and several.para. PostScript groups on 
the same page, you would have to insert /inch 172 
mull def in each group. When Word scans the page for 
PostScript, it does each group in turn and discards the 
variables or routines of that group as soon as it has 
been processed. Even routines or variables placed 
after the .page. command can't be used by other 
groups on the same page. 

3. Executing The Postscript Code-If you print the 
document now, you won't magically have a PostScript­
generated box on the page. The code prints as ordi­
nary text. To have it executed, you must do several 
things. 

First, select the PostScript code (including any group 
command). Then hold down the Shift key and pull 
down the Format menu. You'll see that Styles has 
been replaced by the All Styles command. All Styles 
has several predefined styles, including one called 
PostScript. Select it and click on OK. The PostScript 
code has now been changed into a form that will be 
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interpreted rather than printed. To see the code after 
this point, make sure that Show Hidden Thxt is select­
ed in the Preferences dialog box (Edit menu). You 
can't see the results of your tinkering by using the 
Print Preview command; you must print the docu­
ment on a LaserWriter. 

When you print, make sure that Print Hidden Thxt isn't 
selected in the Print dialog box and check the Chooser to 
make certain that Background Printing is turned off, If 
Background Printing is left on, the PostScript effects will 
be shifted down and to the right from where you want 
them on the first page of the document. Subsequent 
pages will print correctly. 

4. Modifying Word's PostScript Code Style-The on­
screen appearance of Word's native PostScript style 
leaves something to be desired. 

Fortunately, you can easily modify most of the 
attributes. While holding down the Shift key, select 
Define All Styles from the Format menu. Select 
PostScript. The description box defines the style as 
"Normal + Font: 10 point, Bold Hidden." The main 
culprit here is Bold, which makes the type hard to 
read. So just pull down the Format menu while the 
dialog box is showing and turn off Bold. You can safe­
ly change anything in the Postscript style other than 
the Hidden attribute. 

Zapf Dingbat Check Mark With Drop 
Shadow 
Here's how to put a Zapf Dingbat check mark into a 
box with a drop shadow: 

1. Press Command-Y to see the symbols for paragraphs, 
spaces, and tabs. 

2. Press Command-Option-Backslash, and then type 
O(o~). 

3. Select the text (including the backslash), and 
choose Zapf Dingbats from the Font menu. Press 
Command-Y again to hide the paragraph and space 
symbols. You now see a box containing a check mark. 
You can experiment with the various boxes and check 
marks in Zapf Dingbats until you have a combination 
you like. 

Exporting 'Ihbles 
Microsoft Word is a great tool for making tables to 
export into page-layout and drawing programs. 1b 



capture the table's border and cell relationships, you 
must use Word's Copy as Picture command 
(Command-Option-D), but this command doesn't 
work properly when you want to include text that is 
not part of the table with the table (as a title or cap­
tion, for instance). Here's a work-around: 

First, move the table away from the header or caption 
to another part of the document. Select the table, 
choose Copy as Picture, and paste the picture where 
the table was before you moved it. Select the picture 
you just pasted, along with the accompanying title or 
caption, and choose Copy as Picture again. The whole 
thing can now be pasted into the DTP or drawing pro­
gram, and you still have a copy that's suitable for edit­
ing in your Word document. 

At first glance, it may seem easier just to make the 
caption or header part of the table by putting the text 
into a table cell, but because this involves deleting 
columns, repositioning cell boundaries, removing cell 
border, and applying styles, it's generally quicker and 
easier to use the two-step Copy as Picture solution. 

Underlining Equations 
Underlining equations with subscripts or superscripts 
can be hard in Word 4.0. The underline style 
(Command-Shift-U) places separate underlines under 
the subscripted or superscripted numbers. Here's how 
to get a solid underline under equations, whether the 
format is displaced or in-line: 

1. Choose the Show Paragraph command from the Edit 
menu (or type Command-Y). 

2. Press Command-Option-/. This is the preparatory 
command for doing mathematical typesetting. 

3. Enter the letter-typesetting code- in this case, X 
(for the Box command). 

4. Press Command-Option-/ again, followed by BO for 
the bottom border of the box. 

5. Type in the arguments, and enclose them in parenthe­
ses. Apply superscript and subscript fom1atting where 
necessary. 

6. To view the fommla, select Hide Paragraphs. Word's 
typesetting code draws a solid line under the equation 
and won't interfere with the rest of the paragraph's for­
matting. 

WORD 5.0 
Producing White Type On A Black 
Background 
With Word S.O's Border Shading feature, you can easily 
produce white type on a black background. It looks 
great for headings in text or tables. Here's how to do it: 

Hrst select the text (a thick, sans serif font works best). In 
tl1e Character dialog box (Command-D), choose bold for 
the style and white as tl1e text color Click on OK. 

With the text still selected, choose Border from the 
Format menu. Select 100 percent from the Shading 
option (to create a solid black background), and click 
on OK. If you don't want the black background to 
stretch across the page, adjust the right margin on 
the ruler. 

To apply inverted headings quickly, save this format as 
a style. If you plan to reuse the same heading text, 
save it in the Glossary or the Scrapbook. 

You can vary this basic procedure to produce attractive 
headings or chapter titles by changing the text's align­
ment, by using a text color other than white, or by 
using a border shade other than 100-percent black. 

Word Finally Calls Fonts By Name 
With Version 5.0, Word finally calls fonts by name. 

You may have encountered a font substitution prob­
lem at some point. This usually occurs when the ID 
numbers of fonts in your system don't match those in 
another system. This is a problem only if your appli­
cation tracks fonts internally by ID number; in such a 
case, ID number 1578 may be Palatino on your Mac 
and Brush Script on another Mac. Current versions of 
most applications- PageMaker, QuarkXPress, and 
FreeHand, for example-identify fonts by name, 
which eliminates the problem. 

If you use older versions of Word or other programs, 
you may run into problems. One workaround for Word 
is to save files in its Interchange Fonnat (RTF), which 
does store font information by name. 

Copying And Pasting Headers And Footers 
To copy headers and footers into a new document, 
simply select and copy (Command-C) the old docu- ~ 
ment's last paragraph return (turn on paragraph 
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display by pressing Command-} if necessary) and 
paste (Command-V) the paragraph return into the 
new document. It doesn't matter how many pages 
long the old document is. When you display the 
headers and footers in the new document, you'll 
find that the old header or footer text has also been 
copied and pasted. The footers and headers remain 
in the new document even if you delete the pasted 
paragraph return. 

WORDPERFECT 
Working Around The Default Application 
Folder 
WbrdPetfect's file selector usually defaults to the 
WOrdPerfect tOlde~ which is a nuisance if you group doc­
uments into fOlders other than the application fOlder. It's 
also annoying that Page Setup selections can't be saved 
as a part of a style even though they can be saved in a 
document file. 

The solution to these problems is simple under 
System 7: first, start WordPerfect, and then select your 
default style and make whatever changes you want in 
the Page Setup dialog box. When you've saved the 
document as you normally would, save it as a 
WordPerfect stationery pad, and put it into the same 
folder that contains your WordPerfect documents. You 
can also create an alias of the document and place it 
in the folder from which you usually launch 
WordPerfect. It's a good idea to paste the WordPerfect 
application icon on to the stationery document so 
other users will know to double-click on it. 

From now on, whenever you want to use WordPerfect, 
double-click on the stationery pad's alias. Not only 
will you open to an empty document that is set up 
exactly the way you want but your file selector will 
also default to the WordPerfect document folder 
instead of to the application folder. 

Graphic Rulers 
WordPerfect's drawing environment doesn't provide a 
ruler, but there are a couple of easy workarounds. You 
can use a screen-capture utility such as Capture to 
graph the ruler in the main document window and 
paste it into the drawing window. Save the ruler in the 
Scrapbook for future use. The other option is to leave 
an untitled document open with the ruler displayed. 
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Open a second document and then open the drawing 
window. Move the document window down until the 
ruler in the first untitled document becomes visible. 

Quick Kerns 
Kerning is an option of the Layout menu's Line com­
mand. It brings up a dialog box in which you can 
enter kerning values, but a quick kerning method is to 
use the F 1 and F2 keys. 

Place the insertion point between the two letters you 
want to kern. Press Shift-Fl to move letters together 1 
pointorShift-F2 to move them apart 1 point. You'll 
see the change in your document immediately. 

WRITE NOW 
Setting Up Infonnal Style Sheets 
You can set up informal style sheets, using the dummy 
formats that you frequently use, in a document tem­
plate that is kept open whenever you're working in 
WriteNO\v. 

When you need a style, just switch windows, click on 
the paragraph containing the format you need, and 
copy the ruler (Command-1}. Then switch back to 
the document window and paste the ruler in 
(Command-2). Although this method only copies 
ruler settings (not font or style changes, for instance), 
it can still be a real time-saver. It also helps ensure 
that your documents all have a uniform style. 

Later, if you want to change a particular format, you 
can use WriteNow's identical ruler feature. just select 
the text from the first occurrence of the format to the 
end of the document and then hold down the Shift key 
while making the change in its ruler. 

Mac User Hints & Tips is a collection of Mac User's tips, 
tricks, and undocumented features. Edited and com­
piled by Erica Kerwien. Special thanks to Ric Ford's 
keen eyes. Questions regarding this stack can be for­
warded to Erica Kerwien on CompuServe at 72511,241, 
and on AppleLink at EKerwien. Ziff-Davis Publishing 
Company. 
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